
CROSS DJ
 
CROSS DJ for 
U-MIX CONTROL PRO
 
CROSS DJ LE
 
CROSS DJ LE for 
U-MIX CONTROL 2

USER MANUAL

Fine DJ Solutions .



2

Contents

1/ Welcome /5

2/ SoftWare InStallatIon /7

2.1 Installation on Windows /7

2.2 Installation on mac oS X /10

2.3 launching croSS DJ /11

2.4 license Key /11

3/ BaSIc conceptS of DIgItal DJIng /12

3.1 Internal mixer vs. external mixer /12

3.2 audio Sources: audio files vs. external Sources /14

3.3 controlling croSS DJ with the Keyboard and DJ controllers /15

4/ connect anD confIgure your HarDWare /17

4.1 u-mIX control pro in Internal mixer mode /17

4.2 u-mIX control pro in external mixer mode /19

4.3 u-mIX control pro and external audio Sources  /21

4.4	 Configuring	other	Soundcards	 /25

4.5 using the mIDI presets for DJ controllers /30

4.6	 Defining	your	own	Presets	and	Controls /32

4.7 using the Keyboard /41

5/ confIgurIng tHe croSS remote appS /45

5.1 Setting up the ad Hoc network on Windows Xp /46

5.2 Setting up the ad Hoc network on Windows 7 /49

5.3 Setting up the ad Hoc network on mac oS X /53

5.4 connecting the remote app to croSS DJ /54



3

Contents

6/ tHe croSS DJ uSer Interface /57

6.1 the panels at a glance /57

6.2 changing the Screen layout /62

7/ ImportIng anD mIXIng your muSIc /63

7.1 Importing folders /63

7.2 Importing tracks from itunes /63

7.3 Importing collections from other DJ Software /64

7.4 analysing imported files /65

7.5 using the Beatgrid tools  /67

7.6 loading tracks into the players /70

7.7 your first mix /72

7.8 a closer look at the Beat matcher  /74

7.9 customising the players /77

7.10 moving in a track /78

7.11 using the preview player /79

8/ organIzIng your muSIc WItH tHe BroWSer /80

8.1 overview of the Browser /80

8.2 the Dock /80

8.3 the Browser panel /82

8.4 Searching for tracks /84

8.5 using playlists and playlist folders  /85

8.6 using Smartlists /87

8.7 Viewing and editing track meta Information /91

8.8 locating missing tracks /92

8.9 using more than one collection /93

8.10 optimizing the collection Database /94

9/ aDVanceD featureS /95

9.1 using the pitch controls /95

9.2 Snapping loops, locators and cue points /98

9.3 looping /98

9.3 using cue points  /100

9.4 using locators (Hot cues) /102



4

Contents

9.5 effects /103

9.6 recording /110

9.7 using autoplay /112

10/ BacKup your Data /113

A/ Default KeyBoarD SHortcutS /114

B/ trouBleSHootIng anD faQ /117

B.1  Software related Questions /117

B.2  controller related Questions /119

C/ lISt of mIDI meSSageS /122

D/ u-mIX control pro – tecHnIcal SpecIfIcatIonS /127

E/ Safety InStructIonS /129

  InDeX /131

  mIXVIBeS /133



5

1/  
Welcome

thank you for choosing croSS DJ and welcome to the world of digital DJing. 

croSS DJ/croSS DJ le is a great, compact, plug and play, digital DJ solution that 
is available in different packages:

•	 CROSS DJ croSS DJ is the software only package. croSS DJ is compatible 
with every DJ mIDI controller and it includes many built-in mIDI presets for a 
broad range of DJ controllers.

•	 U-MIX CONTROL PRO DJ Package this package consists of the DJ con-
troller u-mIX control pro with integrated soundcard and the croSS DJ 
software.

•	 U-MIX CONTROL 2 DJ Package this package consists of the DJ controller 
u-mIX control 2 and the croSS DJ le software.

•	 CROSS DJ LE croSS DJ le is only available bundled with various controllers 
or other products from different manufacturers

the feature sets of croSS DJ and croSS DJ le are almost identical. the main dif-
ference between croSS DJ and croSS DJ le is that you can use croSS DJ with 
all DJ controllers and DJ soundcards available; croSS DJ le (limited edition) can 
however, only be used in conjunction with the DJ controller that the software was 
bundled with. the bundled controller needs to be connected before you launch 
croSS DJ le. furthermore you cannot customize the mIDI mapping for the bun-
dled controller.

croSS DJ/croSS DJ le was designed to provide a simple and user-friendly envi-
ronment, so you can focus on mixing tracks and having fun.

take a few minutes to run through this manual and you’ll be on your way to making 
great mixes on croSS in no time at all!

Be part of the mixVibes online community and share your experiences with other 
DJs,	find	help	and	advice,	and	also	check	for	available	updates.	See	you	online	on	
the forum (http://forum.mixvibes.com) or on the website (http://www.mixvibes.com).

http://forum.mixvibes.com
http://www.mixvibes.com
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Minimum System Requirements
•	 Windows Xp Sp2, Windows Vista Sp2 or Windows 7. We recommend using 

Windows 7 or Xp instead of Windows Vista.  
or 
mac oS X 10.4 or higher

•	 Intel core 2 Duo/1.8gHz or equivalent cpu

•	 1 gB ram 

•	 one available uSB port 

•	 Hard drive space for music

U-MIX CONTROL PRO Box Contents 
•	 croSS DJ installation disc

•	 u-mIX control pro - uSB DJ mIDI controller with an internal audio interface

•	 1 uSB cable; 1 rca cable; 1 male rca to male mini jack (3.5mm)

U-MIX CONTROL 2 Box Contents 
•	 croSS DJ le installation disc

•	 u-mIX control 2 - uSB DJ mIDI controller

•	 1 uSB cable

CROSS DJ LE Box Contents 
•	 croSS DJ le installation disc

•	 controller of your manufacturer

•	 further content may vary depending on the package you own

please have look at the safety notes for u-mIX control pro and u-mIX con-
trol 2 before using these controllers. the safety notes can be found at the end 
of this manual.
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2/ 
Software  
Installation

please login to our forum (http://forum.mixvibes.com) in order to register your 
product and to check for the latest download version of croSS DJ software. 

Insert the installation disc into the cD-rom drive of your computer and open the 
drive	in	Windows	Explorer	or	Mac	Finder.	Check	the	filename	of	the	installer	applica-
tion as it contains the version number of the software that will be installed. 

If the version available on the mixVibes website is newer than the version on your 
cD-rom, we recommend installing the newer version instead of the one on the 
cD-rom.

2.1 Installation on Windows
1 Insert the installation disc into the cD-rom drive of your computer. the 

installation program will launch automatically. or launch the installer that 
you have downloaded from the mixVibes website.

ATTENTION make sure that the hardware that was bundled with 
croSS DJ/croSS DJ le (for example u-mIX control pro, u-mIX 
control 2, or any other bundled controller or audio interface), is not 
connected during the installation. this ensures that the drivers are 
installed	first,	 before	Windows	detects	 the	device	and	performs	 the	
Plug&Play	device	installation.	Without	the	drivers	being	installed	first,	
Windows tries to search for drivers, which should be avoided as they 
are not installed yet.

 If the installer does not start, open Windows explorer, navigate to the 
croSS DJ installation disc and open it. Double-click on InstallCross DJ.exe 
to launch the installer manually.

2 Select your language and click OK.

http://forum.mixvibes.com
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3 read the license agreement and accept it by clicking I Agree.

4 Select the components you wish to install and click Next. Depending on 
the controller/software package that you use this setup screen may show 
different components. make sure that the driver components for your con-
troller stay selected.
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5 Select the folder where croSS DJ shall be installed. click Next.

6 Select the folder in your Start menu where the croSS DJ shortcut shall be 
created. click Install to start the installation.
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7 once the installation is complete click Finish. If the checkbox Run  
CROSS DJ is activated, croSS DJ will launch automatically.

2.2 Installation on Mac OS X
1 Insert the croSS DJ installation disc into the cD-rom drive of your mac.

2 Double-click the croSS icon on your desktop.

3 Drag and drop croSS DJ onto your “applications” folder.
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2.3 Launching CROSS DJ
If you use croSS DJ le that was bundled with a controller then connect the con-
troller to your computer before you launch croSS DJ le. If the controller is not 
connected croSS DJ le will not start. If you use croSS DJ it is not necessary to 
connect your controller before launching croSS DJ.

TIP If you use the u-mIX control pro controller/audio interface with 
croSS DJ, then connect the controller before you launch the software. 
CROSS	DJ	 supports	 the	 automatic	 audio	 configuration	 of	U-MIX	CONTROL	
pro which means that you do not need to setup your audio routing manually.

Windows go to Start > All Programs > MixVibes > CROSS DJ and click the 
croSS DJ icon.

Mac OS X go to Applications > CROSS DJ and double-click on croSS DJ.

2.4 License Key
During	the	first	launch	of	CROSS	DJ	you	need	to	enter	your	license	key	in	the	fol-
lowing dialog box:

the license key can be found on the sleeve of your installation disc. enter it and 
click Submit.



12

3/ 
Basic concepts 
of Digital DJing

CROSS	DJ	is	a	extremely	flexible	DJ	software	that	can	be	used	in	various	setup	
scenarios.	This	flexibility	can	be	a	bit	confusing	at	first	sight.	This	chapter	provides	
a general overview about some of the basic concepts and terms use in the world of 
digital DJing. If you are already familiar with digital DJing concepts you may wish to 
skip	this	chapter.	If	you	are	using	a	digital	DJ	setup	for	the	first	time,	this	chapter	
will help you to understand the different setup scenarios and audio routing options 
that croSS DJ offers.

3.1 Internal Mixer vs. External Mixer
you can use croSS DJ with either an external mixer or by using the internal mixer 
that is integrated into the croSS DJ software. the main differences between these 
setups are 

•	 whether the audio from the croSS DJ players is mixed inside the internal soft-
ware mixer or inside the external hardware mixer

•	 what audio signal is sent from croSS DJ to the outputs of your audio interface.

Internal Mixer Mode
In internal mixer mode the audio from both croSS DJ players is sent to the inter-
nal software mixer in croSS DJ. the internal mixer mixes the audio depending on 
the position of the volume fader of the players, on the equalization you have made 
and depending on the cue/headphone buttons of the players. any audio changes 
resulting from activated fX will also be mixed into the signal.

after the internal mixing process croSS DJ sends two audio streams to your audio 
interface: one stream contains the mIX/maSter signal that shall be made publicly 
audible; the second stream contains the cue signal that shall be audible in your 
headphones. 

to get optimum results you will need an audio interface that has two stereo out-
puts. one of the outputs is used for the mix, the other for the cue signal. Because 
of the two stereo outputs needed this routing architecture is called Dual Stereo.



13

Basic Concepts of Digital DJing

The	signal	flow	in	this	routing	mode	is	illustrated	in	the	following	graphics:	

CROSS Player
CROSS Mixer  

(Cue, Gain, EQ, FX)

Audio Interface

USB

INPUT OUTPUT

L

1/2 1/2 3/43/4

LR R L LR R

Mix SignalCue Signal

L

R

Cue Signal

Mix Signal

A

B

External Mixer Mode
In external mixer mode the mixing of the audio from the croSS DJ players occurs 
inside	the	external	mixer.	For	this	configuration	you	need	an	audio	interface	with	
two stereo outputs, if you wish to be able to use the stereo signal each player pro-
vides.	The	signal	flow	for	this	setup	is	shown	in	the	following	image:

CROSS Player 
CROSS Mixer (FX)

Audio 
Interface

INPUT OUTPUT

L

1/2 1/2 3/43/4
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Player BPlayer A

Player B

Player A

Mix Signal
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MY

L

R

USB

A

B

the audio signal from player a and player B runs through the mixer/audio engine 
of croSS DJ but only to add the fX amount to the signal. then the audio of each 
player is sent via the uSB port to the connected audio interface: the audio signal 
of player a is sent to outputs 1 and 2, and the audio signal of player B is sent to 
outputs 3 and 4. 

each stereo output of the audio interface is connected with an rca cable to the 
external mixer. you will then use the mixer to perform equalization and to mix 
the audio of both croSS DJ players. the mix out signal of the mixer is sent to the 



14

Basic Concepts of Digital DJing

external	speakers	(or	an	amplifier)	and	the	cue/headphone	signal	of	the	mixer	sent	
to the connected headphone. 

3.2 Audio Sources: Audio Files vs.  
External Sources

Both	setup	scenarios	described	above	use	media	files	(wav,	mp3.	etc)	as	the	audio	
source.	These	files	are	loaded	into	the	CROSS	DJ	players.	Start	the	player	to	hear	
the track.

As	well	as	using	media	files	you	can	additionally	use	an	external	audio	source	in	
croSS. these external audio sources can come from any device that delivers an 
audio signal: turntable, cD player, mp3 player such as an ipod™, an effect device 
and so on. to be able to use external audio sources your audio interface needs to 
be equipped with at least one input that you can connect the external source to.

u-mIX control pro for example provides two stereo inputs that can be used 
to connect external devices and to integrate them into your setup. as croSS DJ 
is built based on a two deck setup you can use a maximum of two external audio 
sources at the same time. the external devices are internally routed to one of the 
two croSS DJ players.

The	following	figure	illustrates	the	signal	flow	in	internal	mixing	mode	when	using	
external audio sources.

CROSS Player A/B
CROSS Mixer  

(Cue, Gain, EQ, FX)

INPUT OUTPUT

L

1/2 1/2 3/43/4

LR R L LR R

Mix Cue

L

R

Cue Signal

Mix Signal
USB

CD Audio 
to Player A 

In this example a cDJ player is connected to the inputs 1/2 of the audio interface. 
the input mode of player a (left part of the mixer panel) has been set to line In. 
In this setting the audio coming from the cDJ player is routed into the croSS DJ 
mixer and you can use the equalizer, the cue button and the fX from player a to 
modify the incoming cD audio. once the audio from the external source is inside 
the	mixer	the	rest	of	the	game	is	identical	to	using	both	players	with	media	files:	
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the croSS DJ mixer sends the mix out signal and the cue signal to the two output 
ports of your audio interface.

of course, you can use external audio sources in external mixer mode as well. In 
external mixing mode the incoming audio is passed through to the audio interface 
output, making a little detour through the croSS audio engine.

3.3 Controlling CROSS DJ with the Keyboard and 
DJ controllers

you can use croSS DJ with the mouse alone. However this is not the quickest way 
to access all features. things get much easier if you use a DJ controller. 

If you bought the u-mIX control 2 or u-mIX control pro package, a control-
ler that is perfectly integrated with the croSS software is part of the bundle. the 
difference between both controllers is that u-mIX control pro is a hybrid con-
troller with an integrated audio interface and u-mIX control 2 is a DJ controller 
only. additionally, the jogwheels on the u-mIX control pro are touch sensitive 
and the jogwheels on u-mIX control 2 are not. for the rest of the DJ controller 
section of both controllers is the same as you can see in the following pictures.
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croSS DJ le can be bundled with controllers from various manufacturers. the 
layout	of	the	controls	on	the	controller	may	vary,	but	you	will	find	controls	that	are	
needed to perform your set.

How does the croSS DJ software know which action should be triggered when you 
press a button on the controller or when you turn a knob or move a fader? every 
time you press a button on your controller, or move a knob or fader, the control-
ler sends a message to the croSS DJ software. these messages are called mIDI 
message	as	they	use	a	protocol	that	is	defined	in	the	MIDI	specification.	MIDI	is	the	
abbreviation	of	Musical	Instrument	Digital	Interface,	an	interface	definition	from	
the	early	80s.	The	MIDI	protocol	is	one	of	the	components	of	the	MIDI	specification	
and	defines	the	structure	and	content	of	communication	between	a	MIDI	sender	
(master) and a mIDI receiver (slave).

Whenever croSS DJ receives a mIDI message, the software looks into a table 
that basically consists of two columns: one column contains information about 
the message and the second column contains information about the action, that 
shall be triggered when that message is received. If there is a match between the 
incoming message and a row in the table, the corresponding action is triggered.

the whole process of connecting a mIDI message to an action is called mapping. 
the term mapping, or better controller mapping, is also used for these “tables” 
explained above. the tables contain the information of how one particular control-
ler is mapped to the action that croSS DJ provides. 

you can have a look at these mappings in all different croSS DJ versions. How-
ever, these mappings can only in croSS DJ be changed. In croSS DJ le you need 
to use the mappings as they are provided, as you cannot modify them.

the same mapping concept is also used for the keyboard as well. croSS DJ con-
tains a standard mapping for your keyboard. It allows access to the most important 
actions. you will learn most of the keyboard shortcuts in the following chapters of 
this manual.
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4/ 
connect and  
Configure	your	
Hardware

this chapter explains how to connect your different hardware components. the 
steps you need to perform depend on whether you use a controller, which one and 
if you wish to use croSS DJ in internal or external mixer mode. also dependant is 
if you wish to use external audio sources like a turntable, a cDJ player or an mp3 
player	with	your	audio	files	on	your	computer

In	its	default	setting	CROSS	DJ	will	configure	all	MixVibes	audio	interfaces	auto-
matically	when	they	are	plugged	in.	You	can	find	the	corresponding	option	Auto-
select MixVibes devices at startup on the Preferences/Audio dialog. If you have 
multiple mixVibes audio interfaces croSS selects them in the following: u46mK2, 
u-mIX44 and u-mIX control pro. 

4.1 U-MIX CONTROL PRO in Internal Mixer Mode
the u-mIX control pro hybrid controller has an integrated audio interface with 
two stereo outputs. one of the outputs is used for the mix out signal, the other one 
is used for the Headphone/cue signal. 

1 use the rca cable and connect outputs 1/2 of your u-mIX control pro to 
the	sound	system	(amplifier,	powered	speakers,	or	home	stereo).

2 connect your headphones to one of the Headphones sockets on the front 
panel of your u-mIX control pro. 
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3 If you wish to use a microphone connect it to the microphone input on the 
front panel of your u-mIX control pro.

4 connect the u-mIX control pro with the uSB cable to your computer.

5 Switch the u-mIX control pro on by setting the on/off switch at the rear 
panel of the controller to uSB. If you are using Windows and if this is the 
first	time	you	have	switched	the	controller	on,	please	wait	until	the	neces-
sary drives are installed.

6 launch croSS DJ.

7 open the File menu and click Preferences. click the Audio tab to 
open	the	audio	settings	panel.	Here	you	can	configure	your	audio	
settings.

8 open the upper list box audio Device and select MixVibes ASIO U-MIX CON-
TROL PRO. you can leave the settings for sample rate and buffer size at 
their default values.

9 open the list box Routing Mode and select Dual Stereo. this routing option 
is to be used for internal mixing mode and if you use an audio interface with 
two stereo outputs.

10 open the list box Output 1. on Windows select U-Mix Control Pro 1/U-Mix 
Control Pro 2 and on oS X select output 1/2, if these outputs are not al-
ready selected. this output receives the master out signal.
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11 open the list box Output 2. on Windows select U-Mix Control Pro 3/U-Mix 
Control Pro 4 and on oS X select output 3/4, if these outputs are not already 
selected. this output receives the cue/monitor signal.

 the routing image in the lower part of the dialog shows the how the audio 
is routed from the croSS mixer to your audio interface. the audio panel 
should	look	as	shown	in	the	following	figure:

4.2 U-MIX CONTROL PRO in External Mixer Mode
If you have an external mixer you can use this mixer to mix the audio coming from 
the two croSS players. the mixer section of the u-mIX control pro controller 
is disabled in this setup. However, all other controls of the controller are available 
to add fX or to use locators, for example. the following steps explain how to con-
nect	the	components	and	how	to	configure	the	audio	routing	in	CROSS.

1 use an rca cable and connect outputs 1/2 of your u-mIX control pro to 
line input 1 of your mixer.

2 use another rca cable and connect outputs 3/4 of your u-mIX control 
pro to a line input 2 of your mixer.

3 connect your headphones to the Headphones sockets on your mixer. 

4 If you wish to use a microphone connect it to the microphone input on your 
mixer.



20

Connect and Configure your Hardware

R
E

A
R

LN  PHLN  PH
DC IN OUTPUT          3/4

POWER
INPUT            3/4 INPUT            1/2

 9V
0.5A

TOUCH S E NS OR
MIN  MAX MIN  MAX

OUTPUT          1/2

LR LR LR LR

USBOFF

C.F. CUR VELE VE L

R               L

USB

SOFTWARE
MIXVIBES

SPEAKERS HEADPHONES

L R

MICROPHONE MIXER

5 connect the u-mIX control pro with the uSB cable to your computer.

6 Switch the u-mIX control pro on by setting the on/off switch at the rear 
panel of the controller to uSB. If you are using Windows and if this is the 
first	time	you	have	switched	the	controller	on,	please	wait	until	the	neces-
sary drives are installed.

7 launch croSS DJ.

8 open the File menu and click Preferences. click the Audio tab to 
open	the	audio	settings	panel.	Here	you	can	configure	your	audio	
settings.

9 open the upper list box audio Device and select MixVibes ASIO U-MIX CON-
TROL PRO. you can leave the settings for sample rate and buffer size at 
their default values.

10 open the list box Routing Mode and select External Mixer. take a look at 
the diagram in the lower part of the dialog box. you can see that the croSS 
mIXer connects DIrect a, i.e. the output of player a, to output 1 of your 
soundcard. DIrect B is connected to output 2.
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11 open the list box output 1. on Windows select u-mix control pro 1/u-mix 
control pro 2 and on oS X select output 1/output 2. this output receives the 
signal from player a. 

12 open the list box Output 2. on Windows select U-Mix Control Pro 3/U-Mix 
Control Pro 4 and on oS X select output 3/output 4. this output receives 
the signal from player B.

4.3 U-MIX CONTROL PRO and External Audio 
Sources 

It is very easy to integrate external audio sources into your croSS DJ setup. an 
internal audio source can be a turntable, a cD player, an mp3 player or any other 
device that provides a line level audio signal. you need an audio interface that has 
at least one input; otherwise it is not possible to use external audio sources.

To	configure	external	audio	sources	three	steps	need	to	be	done:

•	 Make	the	cable	connection	and	configure	the	input	mode	of	your	audio	interface	
input port 

•	 route the external audio source into the croSS DJ software mixer

•	 assign the inputs to the players

•	 Set the player input mode to line In
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ATTENTION	 Before	 proceeding	 with	 the	 configuration	 of	 external	 audio	
sources	make	sure	that	you	have	configured	CROSS	for	either	internal	or	ex-
ternal mixer mode as explained in the previous section..

Making the Cable Connections
the following steps explain how to connect the different components.

1 If you wish to connect a turntable, connect the ground of your turntable to 
the ground lug on the u-mIX control pro.

2 connect the outputs of your external audio source to the rca inputs of your 
u-mIX control pro. plug the left device into inputs 1/2 and the right de-
vice into inputs 3/4.

 make sure that the left channel (plug is white normally) is connected to the 
white rca sockets on the u-mIX control pro, and that the right channel 
(usually red) is connected to the red sockets.
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3 perform one of the following actions:

• Turntable with Phono Output Set the input selector for the inputs 
where the turntable is connected to, to pHono.

• Turntable with Line Output, CDJ Player, MP3 Player  Set the input 
selector for the inputs where the line device is connected to lIne. 

Routing External Audio into the CROSS DJ Mixer
once your external audio source is connected to your audio interface you need to 
tell croSS DJ, which input port of your audio interface shall be assigned as left 
Input and as right Input. 

1 open the file menu and click on preferences. open the audio tab 
of the croSS preferences dialog.
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2 open the list box Left Input and select the input ports of your audio inter-
face to which the external device is connected.

 If you use u-mIX control pro select U-Mix Control Pro 1/U-Mix Control 
Pro 2 on Windows or select input 1/input 2 on oS X.

3 open the list box Right Input and select the input ports of your audio inter-
face to which the external device is connected.

 If you use u-mIX control pro select U-Mix Control Pro 3/U-Mix Control 
Pro 4 on Windows or select input 3/input 4 on oS X.

4 open the Line/Phono dropdown list in section Left Input and/or section 
Right Input. Select Line, if you connect a line-level device or select Phono 
if	you	connect	a	turntable	without	a	pre-amplifier.

5 use the Input Gain sliders next to the Line/Phono dropdown list to adjust 
the input gain for your audio device. make sure that the input level is high 
enough but also that the audio clipping is avoided. Setting the input gain is 
especially useful if you connect an mp3 player like the ipod.

Assign the Inputs to the Players
Once	you	have	configured	the	routing	for	the	Left	Input	and	the	Right	Input	as	de-
scribed in the previous section, have a look at the Head-up Display and especially 
at the a/B buttons at the left and the right side of the waveforms.

If you assigned inputs of your audio interface to the left Input dropdown, then the 
a/B buttons on the left side of the waveform are enabled; otherwise they will be 
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disabled. the same is true for the Right Input dropdown and the a/B buttons on 
the right side of the waveform.

If the buttons are enabled, you can use them to assign the left Input and/or the 
right Input to either player a or player B by clicking the corresponding buttons. 
the following image shows an example, where only the left Input channels of the 
audio interface were routed. also the left Input was assigned to player a. 

Right Input is not configured 
Buttons are disabled

Left Input is configured 
Buttons are enabled

Left Input assigned to Player A

Setting the Player Source to Line In
the last step that needs to be done is to set the Input mode of the croSS DJ player 
to line In, if you wish the external audio source to be heard through the player/
mixer. the input mode button can be found on the mixer panel above the equalizer/
gain knobs. 

Player A is set to 
Input Mode Line In

Player B is set to 
Input Mode Player

you can set the input mode to player or to line In.

• Player	 When	the	input	mode	is	set	to	Player	the	audio	from	the	media	file	is	
sent to the croSS mixer.

• Line In When the input mode is set to line In, the external audio signal is sent 
to the croSS DJ mixer. Which of the external inputs is sent to either player a 
or B depends on the selection you made in the Head-up Display (see previous 
section).

If you use either u-mIX control pro or u-mIX control 2 you can set the input 
mode on the controller by holding the Shift button and pressing the Headphones/ 
Source button.
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Hold Shift and press button to select the Input Mode

4.4 Configuring other Soundcards 
If you use any audio interface other than the u-mIX control pro this section will 
provide all the information that is necessary to get your soundcard up and running 
with croSS DJ. 

In general you can use any soundcard with croSS DJ. However, using a soundcard 
that has at least two stereo outputs gives the best results and a better experience. 
If you wish to integrate external audio sources, like a turntable, cD player, mp3 
player etc into your setup, then you will need an audio interface that has one stereo 
input for each device you wish to connect.

1	 Connect	your	equipment	(audio	interface,	speakers/amplifier,	headphones)	
by performing one of the following actions:

•	 If you use croSS DJ in internal mixer mode connect the speakers/your 
amplifier	and	your	headphones	to	the	corresponding	outputs	of	your	au-
dio interface. Some DJ audio interfaces have a designated headphone 
output, sometimes you can assign one of the available outputs as the 
headphone output. please consult the manual of your audio interface 
for more information. 

•	 If you use croSS DJ in external mixer mode connect each stereo output 
of your audio interface to a stereo input of your mixer.

2 If you wish to integrate external audio sources, like a turntable, a cD player 
or an mp3 player, into your setup, perform the following actions:

•	 connect the components you wish to use to the inputs of your audio 
interface. 

•	 If you are using a turntable that provides a phono level signal and if your 
audio interface has a switch to toggle the input between phono and line, 
make sure that the switch is set to phono.

3 open the File menu and click on Preferences. open the Audio tab 
of the croSS DJ preferences dialog.

4 open the Audio Device dropdown list and select the audio inter-
face/driver that croSS shall use.
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 Windows If you are running croSS DJ on Windows, the dropdown list 
shows all audio drivers installed on your computer, even when the audio 
interface is not currently connected. 

 the dropdown list on Windows contains two sections. one section is la-
belled DirectSound and the other second one, aSIo. two drivers are often 
installed for the same audio interface; one using the aSIo protocol and the 
other one using the DirectSound driver architecture. If both drivers are 
available you should use the aSIo driver as aSIo drivers generally offer 
better performance than DirectSound drivers (see sidebar on page 29).
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TIP If no aSIo driver for your audio interface is available you can use the 
aSIo4all driver as an alternative. aSIo4all is a hardware independent low 
latency aSIo driver for Windows audio devices and acts as a layer between the 
DirectSound driver and the audio application, which here is croSS DJ. once 
you	have	installed	ASIO4ALL	you	need	to	configure	the	driver	and	tell	it,	which	
Windows audio drivers it shall use. then you should select the aSIo4all dri-
ver in the croSS audio setup.

using aSIo4all can lead to better audio performance, to a lower latency time 
and can help to avoid clicks and pops. even though a guarantee cannot be 
given,	checking	ASIO4ALL	is	definitely	worth	while.

please note that the latency time when using aSIo4all is always greater 
than	with	a	generic	ASIO	driver	because	the	audio	data	from	CROSS	is	first	
sent via the aSIo protocol to aSIo4all and then via the WDm protocol to the 
audio interface. for this reason using aSIo4all should be seen more as a 
workaround.

 OS X If you are running croSS DJ on oS X only the currently available and 
connected audio interface is shown. all drivers you see in the list are core 
audio drivers.

5 click the Sample Rate button with the sample rate you wish to use. 

 the default setting is 44.1 kHz, which is the same sampling rate used by 
audio cDs. In most cases this default setting is acceptable.  

 By changing the sample rate you instruct croSS DJ that all audio data it 
sends to your audio interface has to be at the selected sample rate. this 
means	that	even	compressed	audio	file	formats	(like	MP3),	need	to	be	re-
sampled by croSS DJ before the audio is sent to the outside world.

 Even	if	you	only	use	standard	WAV	files	that	have	a	sample	rate	of	44.1	kHz	
the sound will not be improved if you change the sample rate to 88.2 kHz, 
for example. However, if you use your own audio material that has a higher 
sample rate, it makes sense to change the sample rate that croSS will 
use.

6 use the slider Buffer size to change the latency time of your audio inter-
face. the default buffer size is 256 samples. 
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 the latency time is a measure of the time it takes until an action in croSS 
DJ (like jumping to a locator) is audible. generally speaking a latency time 
around 10 milliseconds is considered an adequate and decent value.

TIP If you hear clicks and pops in the audio output of croSS DJ or 
if the audio output is interrupted then in most cases the solution is to 
increase the latency time. Why this helps and the reasons for the dis-
tortions are explained in the sidebar on page 29.

7 If you are using external audio sources open the list boxes Left Input and 
Right Input  and select the inputs of your audio interface that the devices 
are connected to.

 once you select an input port you will see a slider that you can use to 
change the input gain of that input, and a list box to select whether a phono 
level or a line level device is connected.

8 open the list Output 1 and perform one of the following actions:

•	  If you use croSS DJ in external mixer mode select the outputs of your 
audio interface where croSS DJ shall send the audio from player a to.

•	 If you use croSS DJ in internal mixer mode select the outputs of your 
audio interface where croSS DJ shall send the master/mix signal to. 

9 open the list Output 2 and perform one of the following actions:

•	  If you use croSS DJ in external mixer mode select the outputs of your 
audio interface where croSS DJ shall send the audio from player B to.

•	 If you use croSS DJ in internal mixer mode select the outputs of your 
audio interface where croSS DJ shall send the cue/Headphone signal 
to. 

the outputs available in the list boxes depend on the audio inter-
face/driver that you selected in step 4. the screenshot above uses an  
m-audio firewire soundcard as an example.
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10 use the button LIMITER to enable/disable the software limiter inside 
croSS.

 the limiter ensures that the level of the audio signal never exceeds a par-
ticular value. this is to avoid clipping.

11 open the Routing Mode list box and select the routing mode you wish to 
use.

 croSS provides four different routing modes where each option supports a 
different usage scenario:

• Dual Stereo use this option if you have an audio interface with two 
stereo outputs and if you wish to use the internal croSS DJ mixer. one 
output is used for the master/mix out signal; the other one is used for 
the cue/Headphone signal.

• External Mixer use this option if you use croSS DJ in external mixer 
mode. In this mode the output of each croSS DJ player is sent to a 
dedicated output on your audio interface.

• Simple Stereo In this mode the sum of the master and cue/monitor 
signals are routed to one output on your audio interface. you can use 
this option when using an audio interface with only one output (normally 
the internal soundcard of your laptop). 

• Split Mono use this option if you have one stereo output. this is usu-
ally the case with almost all soundcards that are integrated in laptops. 
croSS DJ sends the master/mix out signal to the left channel of the 
output and the cue/Headphone signal to the right channel of the output. 
You	get	two	mono	signals	in	this	configuration	but	you	are	still	able	to	
use the cue/monitor feature of croSS DJ.

NOTE When using routing mode Split Mono or Simple Stereo you 
only need to perform step 9 (setting output 1), as with both routing 
modes, only one output is needed.

Sidebar: ASIO, Latency and Buffer Size
as a general rule the lower the latency time, the better. But: a low latency time 
can cause some issues. one is caused by the method by which the audio data is 
sent from the application (in our case croSS DJ) to the audio interface (to be more 
precise: to its digital-to-analogue converter, which transforms the audio data into 
audible sound).
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to guarantee a continuous data stream the audio drivers provide a data buffer. 
croSS DJ writes the generated audio data into this buffer. the audio driver then 
transfers the received data to the audio interface hardware and the hardware 
makes the data audible. to achieve a lower latency the data buffer needs to be as 
small as possible. With a small buffer the amount of audio data is very small and 
croSS needs to update the data buffers more often to make sure that the data 
stream is not interrupted. 

the buffers need to be refreshed very rapidly after each action that is performed 
in croSS DJ, and the result of this action is audible because of the small size of 
the buffers.

However, the problem here is that croSS DJ needs to share the processor time 
with other applications and the operating system. If croSS DJ cannot update the 
data buffers quickly enough the data stream is interrupted. this can lead to either, 
disturbing clicks and popping noises or in the worst case to real “holes” in the au-
dio signal. and: a smaller buffer results in a higher cpu load because croSS DJ 
needs to write data into the buffers more frequently.

When larger data buffers are used, the clicks and pops disappear; the disadvan-
tage is that this also increases the latency. Because of the larger buffers, it takes 
more time for croSS DJ to write new audio data into the buffers (i.e. until the data 
in the buffers is “consumed”).

the actual latency time is also dependant on the buffer size and the number of 
operating system layers the audio data needs to walk through until it reaches the 
audio interface hardware. mac users do not need to worry about this. the core au-
dio drivers were originally designed in a way that their latency time is quite small.

to overcome these latency and other issues with earlier Windows audio drivers 
(and as a way to improve sale of their own products) german company Steinberg 
developed the aSIo protocol (audio Stream Input/output), which in 1997 became 
an open standard, whereby other manufacturers could develop hardware and driv-
ers that used this protocol. the main goals for the development of aSIo were to 
give applications direct access to the input and output functions of the audio inter-
face and so to avoid the need for data to be transported via several layers in the 
operating	system	first.	This	results	in	a	better	data	throughput	and	in	a	decrease	in	
latency time. at the same time aSIo removed the previous restriction that only one 
stereo output and one stereo input could be used and made it possible to create 
and support audio interfaces with several inputs and outputs.

4.5 Using the MIDI Presets for DJ Controllers
croSS DJ/croSS DJ le come with many mIDI presets which allow you to control 
the software from your DJ controller. 
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If you use croSS DJ with u-mIX control pro or u-mIX control 2 make sure 
that the controller is connected before you launch the application. During start-up 
croSS DJ will detect the controller and its mIDI preset is activated automatically.

croSS DJ le automatically checks if the bundled controller is connected. If the 
bundled controller cannot be found, croSS DJ le cannot be launched. otherwise 
croSS DJ le will automatically activate the mapping for the controller.

If you use any other controller, please connect it to your computer before launch-
ing croSS DJ. once you see the main window perform the following steps to as-
sign the mIDI port of your controller to one of the mIDI presets:

1 open the File menu and click Preferences. click MIDI to open the MIDI tab. 
for each mIDI port/controller croSS DJ could detect, you will see a tab 
with the controller name/port name at the top of the panel.

2 click the tab with the controller name/port name, for which you wish to as-
sign a mIDI preset.

3 Scroll through the list Controller and click the mIDI preset you wish to as-
sign. the following image shows an example with one detected controller 
(here mixVibes u-mIX control pro). this controller is assigned to the 
mIDI preset with the same name. 

4 repeat steps 2 and 3 if you wish to use more than one controller. 
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MIDI Presets Documentation
To	have	the	documentation	of	the	MIDI	preset	at	your	fingertips	you	can	print	the	
corresponding	PDF	file.	On	Windows	browse	to	the	folder	with	the	CROSS	DJpro-
gram	files	and	open	the	subfolder	Documentation\MIDI Controllers. Search for 
the	PDF	file	with	your	controller.

On	 OSX	 the	 PDF	 files	 are	 not	 installed	 by	 default.	 To	 access	 them	 insert	 your	
croSS DJ installation disc into the cD rom drive. Double-click the croSS icon 
on your desktop. finally open the Documentation/MIDI Controllers folder on the 
installation	disc	and	all	available	PDF	files	are	shown.

All	PDF	files	are	also	available	on	the	MixVibes	website	(www.mixvibes.com).	Open	
the page Documentation in section Support and Downloads for the croSS DJ 
product.

4.6 Defining your own Presets and Controls
the standard mIDI presets, also called controller mappings, that come with croSS 
DJ cannot be changed. presets that cannot be changed are marked with the lock 
icon in list Controller (see previous page).

However, you can create a duplicate of a standard mIDI preset and then use this 
duplicate to make your own changes, such as deleting and adding controls. If there 
is no mIDI preset available for the controller you wish to use, you can create your 
own, or you can import a mIDI preset that another croSS DJ DJ has shared on the 
mixVibes forum. 

NOTE In croSS DJ le it is not possible to change or edit the mIDI presets; 
you can use the supplied preset only. therefore the Preferences dialog in 
croSS DJ le does not provide a MIDI tab.

Creating a Duplicate of a MIDI Preset
perform the following steps to create a duplicate of one of the standard mIDI pre-
sets:

1 open the File menu and click Preferences. click MIDI to open the MIDI tab. 

2 click the tab with the controller name/port name of the controller, which 
mIDI presets shall be duplicated.

3 Scroll in list Controller and select the mIDI preset you wish to duplicate.

4 click the button Duplicate Controller Mapping at the bottom of 
the Controller list. 

www.mixvibes.com
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 croSS DJ show the Controller Info dialog.

5 enter a name for the mIDI preset, like “my cDJ 400 preset”. change the 
version number and the author name in the two text boxes in the lower part 
of the dialog. If you wish to change the icon for the duplicated preset, click 
Browse,	open	the	folder	with	the	image	file	and	click	Open.

 finally click OK.

6 the duplicated preset is added to the end of list Controller. you can now 
change and edit the mapped controls (see section “editing a mIDI preset” 
below). 
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TIP If you wish to change the controller information, select the preset 
in list controller and click the button Edit Controller Info.

Creating a new MIDI Preset
If there is no default mIDI preset available for the controller you wish to use, you 
can create your own. first add an empty mapping (this section) and then add the 
controls to this mapping (next section). perform the following steps to create a 
new controller mapping:

1 open the File menu and click Preferences. click MIDI to open the MIDI tab. 

2 click the tab with the controller name/port name of the controller, which 
mIDI presets shall be duplicated.

3 click the button Add Controller Mapping at the bottom of the Con-
troller list. croSS DJ opens the Controller Info dialog.

4 enter a name for the mIDI preset, like “trigger finger”, change 
the version number and the author name in the two text boxes in the lower 
part of the dialog. If you wish to change the icon for this controller mapping, 
click Browse,	open	the	folder	with	the	image	file	and	click	Open.
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 finally click OK.

5 the new controller mapping is added to the end of list Controller. 

you can add controls to your new mapping (see section “editing a mIDI preset” 
below).

Editing a MIDI Preset 
each mIDI preset/controller mapping consists of one of more controls. a control is 
a function of croSS DJ that can be controlled with a mIDI controller. all available 
controls are grouped by the function categories that are shown in list Mappings of 
the Preferences/MIDI dialog. you can open a category by clicking the Plus button 
in front of the category name.

Inside each category you can see the controls that can be mapped to the buttons, 
faders and knobs of your controller. In the following image the category FX 1 is 
opened. fX 1 refers to the fX unit of player a. there are four different controls that 
you can assign to your controller, like on/off and amount for example.
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the control on/off has been assigned to the controller. a grey button shows 
information about the mIDI message that the button on the controller sends to 
croSS DJ. you can click this button to change the assignment between the control 
and the button/knob/fader on your controller. at the very right you can see buttons 
with a minus sign and a plus sign. clicking the Minus button remove the mapping 
for a control; clicking the Plus button opens a dialog where you can create a new 
mapping.

let’s have a look at some examples that will explain the basic steps and the differ-
ent options for mapping a control. 

1 click the Plus button before the category with the control that you wish you 
map. for this example open category FX 1.

2 click the Add mapping button next to ON/OFF. the 
mIDI control mapping windows is opened.
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3 press/move the mIDI button/mIDI control that you want to assign to fX1 | 
on/off. croSS DJ receives a mIDI event from your controller. 

 In section MIDI event you can see information about the mIDI event that was 
received. In this example we have pressed a button. Buttons normally send 
Note	messages	(here	0x46;	the	prefix	0x	is	shown	as	the	shown	number	is	
a hexadecimal value). mIDI events are sent on a particular mIDI channel; in 
this	example	the	controller	was	configured	to	send	its	messages	on	chan-
nel 10.

 now have a look at section Available Presets. for an event that was trig-
gered by a button and that is mapped to a croSS DJ control with on/off 
states, croSS DJ provides two different presets. you can select one of the 
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available	presets	to	define	how	croSS DJ shall react when this mIDI event 
is received. If you choose Toggler Button then this event toggles the state 
of the mapped control: if the current status is off the status will be set to 
on; if the current status is on then pressing the mapped button will set the 
state to off.

 If you choose Holder Button, then the status of the control will change as 
long as the mapped button is held. 

 additionally you can activate the Invert check box in section Preset Op-
tions. If you have mapped a control as a Holder Button, the mapped feature 
is on while the mapped button is held. However, if Invert is activated, the 
mapped feature is off, while the mapped button is held.

4 click OK to add the mapping to the mIDI preset.

5 click the Add mapping button next to Amount. the mIDI control mapping 
windows is opened.

6 move a fader or a knob on your controller and have a look at the available 
options.

 for controls that are used to set a croSS DJ control to a particular value 
and where a fader or a knob is moved, the mIDI control mapping windows 
offers the presets Direct Fader/Knob and Inc.-Dec Normal Fader/Knob. 
In general you should use Direct Fader/Knob for faders and knobs with 
a	defined	start	and	end	point	and	you	should	use	Inc.-Dec Normal Fader/
Knob for endless encoders.

 In section Preset Options you see the Invert option that you know already 
from	the	first	example.	Use	Invert for faders and knobs if you wish to invert 
the meaning of the left/right or up/down movement or position of the mIDI 
control.
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7 for controls like amount that set a value, not only faders and knobs but 
buttons can be used if you wish to set the value stepwise. make sure that 
the mIDI control mapping dialog for the amount control is still open and 
press a button on your controller. the available Preset Options change as 
shown	in	the	following	figure:

 use the preset Direct Normal Button if you wish to set the control to a par-
ticular	value.	Use	the	Value	field	in	section	Preset	Option	to	define	the	value	
in the range from 1 to 100.

 use the preset Normal Inc. Button or Normal Dec. Button if you wish to 
change the value stepwise. using Normal Inc. Button increases the value 
and Normal Dec. Button decreases it. then enter the step size into the 
field	Value. the step size can be in the range from 0.00 to 1.00. addition-
ally you can activate the auto-repeat option, if you want the value to be 
decreased/increased not just once, but for as long as the mapped button is 
held.

 the two presets Normal Inc. Trigger and Normal Dec. Trigger lead to the 
same result as using the corresponding button presets. However, for a 
control mapped to a trigger function no auto-repeat options are not avail-
able.

8 now open the category Application and click the Add Mapping button next 
to Activate Next Player. activate next player can be used to set the input 
focus to one of the players. all commands that are mapped in the category 
Current Player are sent to the player that is currently active.

9 press a button on your controller and take a look at the available presets.
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 Some of the controls do not have an on/off state, like the FX On/Off control 
you saw earlier. they are used only to trigger an action, like setting the in-
put focus as activate next player does. for these controls the presets Trig-
ger Button and Trigger Note are available. If you use the preset Trigger 
Button you can activated the Auto-Repeat option as shown in the previous 
image. for the Trigger Note preset this option is not available.

this ends the introduction into how to map your own controls. 

Importing a Mapping 
If you have found a mIDI preset for your controller on the mixVibes forum or if you 
received one from another croSS DJ user, perform the following steps to import 
the mapping.

1 open the File menu and click Preferences. open the MIDI tab on 
the Preferences dialog.

2 Select your mIDI device by clicking on its tab.

3 click the Import Controller Mapping button in the lower part of the 
Controller list.

4 Browse	 to	 the	 folder	with	 the	mapping	file	 (file	extensions	 .map-
pings,	.mappings.xml),	select	the	file	you	want	to	import	and	click	Open.

5 assign the imported mapping to the mIDI device by clicking the picture of 
the mapping in list Controller.
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Exporting a Mapping
If you created amapping for a controller and wish to share it on the mixVibes forum, 
perform	the	following	steps	to	export	the	mapping	into	a	file	that	can	be	uploaded.

1 open the File menu and click Preferences. open the MIDI tab on 
the Preferences dialog.

2 Select your mIDI device by clicking on its tab.

3 click the Export Controller Mapping button in the lower part of the 
Controller list.

4 Browse	to	the	folder	where	you	want	to	save	mapping	file	(file	ex-
tensions .mappings) and click Save.

4.7 Using the Keyboard
If your DJ controller is not currently available or if you are preparing tracks or 
playlists you can use your keyboard to access many of the croSS DJ features. 
croSS DJ includes a keyboard mapping that is automatically activated when you 
launch the software. please have a look at the tables on page 104 and onwards for 
a complete overview of the integrated shortcuts.

Player related shortcuts
many of the keyboard shortcuts control the features the two players but only one 
keyboard shortcut has been assigned. In these cases the mapped command is sent 
to the currently active player. please have a look at the yellow and red bar respec-
tively, that is visible above the track title if that player is active.

you can toggle the active status of the player by pressing the (ÿ) key.

Defining your own Shortcuts 
If you wish to access a croSS DJ feature for which a shortcut is not included in the 
default	mapping,	you	can	define	the	shortcut	yourself.	This	example	shows	how	to	
define	a	shortcut	for	the	Kill	Bass	feature	in	the	mixer.

1 open the File menu and click on Preferences. click the Keyboard 
tab.

 the Controller list shows all keyboard mappings that are avail-
able. please note the lock icon, it indicates that the mapping is 
embedded and cannot be changed. the Mappings list shows the different 
command categories that can be assigned.
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 as we wish to add two new keyboard shortcuts to an existing mapping the 
easiest way is to duplicate an existing mapping and make the desired 
changes there.

2 click the Duplicate Controller Mapping button in the lower 
part of the Controller list. the Controller Info dialog becomes 
opened.

3 enter a descriptive text into the Model	field	and	click	OK. 

 Have a look at the list Controller. there are three different keyboard map-
pings available now: the two embedded mappings and the duplicate you 
just created. only one of the mappings can be active at one time. 
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4 make sure that the duplicated mapping is selected in the list Controller. 

5 click the Plus button before the category Mixer to expand this node. you 
now see all mappable commands and the shortcuts that are already de-
fined	for	some	of	the	commands.

 6 click the Add mapping button next to Bass Kill A. 
the keyboard control mapping windows is opened.

7 press the (F8) key. the pressed key is shown as a 
keyboard event. you can now choose between two 
different presets. these presets are identical to those you see when you 
create a mapping for a mIDI controller.
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• Toggler Button a toggler button toggles the status of the mapped 
command between on and off.

• Holder Button a holder button activates the mapped command only 
for as long as the key is held.

•	 you can use option Invert if you wish to invert the functionality of the 
control (see page 38).

8 leave preset Toggler Button activated and click OK to close the Keyboard 
control mapping window.

9 repeat steps 6 to 8, but this time add a mapping for the Bass Kill B com-
mand and assigned it to the [F9) key.

10 close the Preferences dialog and check, if the new keys are working.

Importing and Exporting Keyboard Mappings
Keyboard mappings can be imported and exported in the same way as explained 
for controller mappings (see page 40 and onwards). make sure, that the Keyboard 
panel of the Preferences dialog is open if you wish to import or export a keyboard 
mapping.
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Configuring	the	
croSS remote 
apps

With the croSS remote apps you can control croSS remotely from your ipad, 
your ipod touch, or from your iphone. the remote apps simulate an external Wi-fi 
external DJ controller. all mixing is done in the croSS software running on your 
mac or on your pc. In this setup your standard audio interface is used so you will 
achieve the sound quality that you expect from professional DJ software.

communication between croSS and the remote apps is bi-directional. this allows 
sending commands from the remote app to croSS as you would expect. at the 
same time the names of the loaded tracks and all playback information (current 
tempo, current playback position, remaining play time and so on) are visible on the 
remote app screen, because croSS can send this information to your remote app.

the croSS remote apps are available in the apple app Store. once you have pur-
chased	and	installed	the	remote	app	you	need	to	configure	the	wireless	adapter	
of your laptop. the steps you need to follow are slightly different depending on the 
operating system you are using for croSS. the following sections contain detailed 
information for Windows Xp, Windows 7, and mac oS X. once the Wi-fi network has 
been created you can connect your croSS remote app to croSS.
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5.1 Setting up the Ad Hoc Network on Windows XP

perform	the	following	steps	to	configure	an	Ad	Hoc	network	on	Windows	XP

1 open Control Panel and open the Network Connections applet.

2 Deactivate all internet connections. you can use u-mIX remote while your 
internet connections are active. However, for performance reasons we rec-
ommend deactivating your internet connections.

 Also	deactivate	your	antivirus	software	and	your	firewall	to	make	sure	that	
u-mIX remote can connect to croSS via the wireless connection.

3 right-click on Wireless Network Connection and select Properties.

4 open the Wireless Networks tab and click Add.

5 enter a name for the network into the Network Name (SSID)	field,	deacti-
vate the option The key is provided for me automatically, select WEP as 
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data encryption mode and enter a password of 5 or 13 characters into the 
Network Key	field.	Finally	click	OK.

 the new network should appear in the networks list, as shown in the fol-
lowing image.

6 click on Advanced to open the Advanced dialog box. make sure that op-
tion Computer-to-computer (ad hoc) networks only is selected and click 
Close.
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7 right-click the icon Wireless Connection	icon	in	the	notification	area	of	the	
Windows task bar. Select View Available Wireless Networks in the context 
menu. 

8 If the network you just created is not connected yet, select it in the networks 
list and click Connect. 

 Windows will show the following dialog box informing you that the network 
is activated and that it is waiting for devices to connect.
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now continue as explained on page 54 to connect your remote app to croSS DJ.

5.2 Setting up the Ad Hoc Network on Windows 7

perform	the	following	steps	to	configure	an	ad	hoc	network	on	Windows	7:

1 right-click the icon Wireless Connections	 in	 the	notification	area	of	 the	
task bar. Select Open Network and Sharing Center in the context menu. 

2 Deactivate all internet connections. you can use u-mIX remote while your 
internet connections are active. However, for performance reasons we rec-
ommend deactivating your internet connections.

 Also	deactivate	your	antivirus	software	and	your	firewall	to	make	sure	that	
u-mIX remote can connect to croSS via the wireless connection.

3 In the Network and Sharing Center window click on Setup a new connec-
tion or network.
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4 In the Setup a new connection or network dialog click on Set up a wireless 
ad hoc (computer-to-computer) network.

5 enter a network name, select WEP in list Security type and enter a pass-
word of either 5 or 13 characters into the Security key	field.	Click	Next.
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6 Windows will show the dialog you see in the following image. click on Close 
to return to the Network and Sharing Center. 

 the Network and Sharing Center	will	look	like	shown	in	the	following	fig-
ure. the new network is created and is waiting for devices to connect: 

7 open the Settings app on your ipad, go to Wi-Fi, turn Wi-fi on if it is cur-
rently off. then select the network you just created from the list of net-
works. enter the password you selected while creating the ad Hoc network 
in Windows and tap Join. 

the Network and Sharing Center should now look as shown in the follow-
ing	figure:
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 It takes a while (most often between 2 and 5 minutes) until the network and 
Sharing center is updated and will show the connected status:

8 close the network and Sharing center.

now continue as explained on page 54 to connect your remote  app to croSS DJ.
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5.3 Setting up the Ad Hoc Network on Mac OS X

perform	the	following	steps	to	configure	an	ad	hoc	network	on	Mac	OS	X.

1 click the AirPort icon in the menu bar and then click on Create Network.

2 enter a name for the new network. Select 40-bit WEP in list Security, enter 
a password into the Password and Verify	fields	and	click	OK.
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now continue as explained in the next section to connect your remote app to 
croSS DJ.

5.4 Connecting the Remote App to CROSS DJ
once you have created the ad Hoc network and made the connection between your 
computer and your ipad, ipod touch, or iphone you need to connect youre remote 
app and croSS DJ by performing the following steps:

1 open the Settings app on your ipad/ipod touch. or iphone, go to Wi-Fi, and 
turn Wi -fi on if it is currently off. Select the network you have just created 
from the list of networks. enter the password you selected while creating 
the ad Hoc network and tap Join. 

2 go to croSS DJ. open the File menu and click Preferences. click Remote 
to open the Remote tab.
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3 make sure that the check box Use Remote Apps is activated.

4 launch the remote app on on your ipad/iphone/ipod touch. 

5 the start screen of your remote app shows the names of all computers (not 
the network names) that are connected to the ad Hoc network and that are 
running croSS DJ with Use Remote Apps activated on the Preferences/ 
Remote tab.
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6 Select the computer you wish to connect to.

7 return to croSS DJ. on the Remote tab you see that a connection request 
from the remote app has arrived. click Accept to accept the connection.

 your remote app will connect to croSS DJ and the app should be ready to 
go.

TIP If the connection lags for more than 30 seconds, uncheck the Use Re-
mote Apps checkbox in cross and re-check it to reinitialize the connection. If 
this does not help, restart cross.
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6/ 
the croSS DJ 
user Interface

the user interface of croSS DJ is composed of several panels, where each panel 
has its own functionality. the feature set of some panels, like the mixer, is based 
on the functionality known from classic analogue DJing. other features, like the 
Beat matcher in the Head-up Display or the match and Sync functionality, are tools 
unique to digital DJing.

6.1 The Panels at a Glance
the following graphics shows the different panels of croSS DJ user interface.

Head-Up Display (HUD)

Player A Player B

Advanced Controls Player A Advanced Controls Player B

Browser and Preview Player

Recorder

Mixer
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Selecting the User Interface Language
If the user interface is not in your language or the language you wish to use you can 
change it. open the file menu and click on preferences. make sure that the Display 
tab is open. open the list language and select your preferred language.

Head-Up Display
the Head-up Display in the upper part of the croSS DJ windows is the control 
centre for the external inputs and it contains the Beat matcher, which serves as a 
visual guide for getting your tracks beat synchronised. When the media loaded into 
one of the players contains artwork, like a cover image, it is shown in the Head-up 
Display.

Left Input 
Player Assignment

Right Input 
Player Assignment

Cover Image Player A                                  Beat Matcher                              Cover Image Player B

Left Input 
Level Meter

Right Input 
Level Meter

the buttons a/B at the left and the right side of the Head-up Display allow to con-
nect external inputs to player a or player B. the buttons on the left control the 
source	configured	as	Left	 Input	and	 the	buttons	on	 the	right	control	 the	source	
configured	as	Right	Input	(Preferences dialog, Audio tab).

When	there	is	no	external	source	configured	to	an	input	then	the	corresponding	
buttons are disabled, as you can see for the right Input in the image above. oth-
erwise the buttons are enabled and you can click them to select, via which player 
the external source shall be audible. an external input can only be assigned to one 
of the players.

let’s assume that your mp 3 player like the ipod™ is connected to the left Input, 
you	have	an	audio	file	playing	 in	player	A	and	that	you	wish	to	play	some	music	
from the mp3 player next. to achieve this you should click button B on the left side 
of the Head-up Display to be able to get the music from your mp3 player into the 
croSS DJ mixer.

the largest part of the Head-up Display is occupied by the Beat matcher. the Beat 
matcher displays the peak/transient information of the tracks currently playing in 
the two players. for tracks that have a beatgrid, croSS can also show the grid on 
the Beat matcher. additionally, you can enable the Bar Sync meter and the cycle 
Sync meter, which serve as a visual guide when beat mixing your tracks. the beat-
grid and the sync meters can be activated on the Display tab of the Preferences 
dialog. 
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Player A and B
the largest area of the croSS DJ user interface is occupied by the two players. 

Pitch and Tempo 

Transport

Playback Info

Waveform with Beatgrid

Full Track Display

the player on the left is called player a (yellow); the player on the right is player 
B (red). the waveform area shows a section from the track currently playing. you 
can use the outer buttons to zoom in, zoom out and to reset the waveform to the 
default zoom factor. the white vertical line is the play marker and marks the part 
of the track that is currently audible.

the inner panel of the players contain the pitch faders that work similarly to the 
pitch faders that can be found on turntables and cDJ players.

the section with the black background shows some vital playback information: the 
current time, the remaining time, the current Bpm and the current tempo change 
as a percentage value.

the transport section contains the play/pause and the cue buttons; they work in a 
similar way to the corresponding buttons on a cDJ player. you can use the Smart 
Seek buttons in the transport section to jump forward/backward in a track and 
define	 the	 jump	 length	 in	beats	or	 fractions	of	a	beat.	Click	 the	Reverse	button	
at the right side of the transport section if you wish to play the track backwards.

Advanced Controls for Player A/B
Below the player you see a panel with the advanced controls. they allow you to 
set locators/hot cues in your tracks, to create automatic and manual loops and to 
modulate the player audio with the effects. chapter 9 starting on page 88 takes a 
closer look at the features of the advanced controls panel

Locators/Hot Cues                              Effects

Loops
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Mixer
there are two different views for the mixer panel: one for internal mixer mode and 
another one for external mixer mode.

The	Mixer	panel	in	internal	mixer	mode	has	all	the	controls	that	you	would	find	on	
a classic DJ mixer:

•	 the Volume section with three knobs where you can control the mas-
ter out volume, the Headphone volume and the ratio between the 
monitor and the mix signal that is sent to the Headphones.  
the master Volume can be set on u-mIX control pro with the master knob 
on the top panel of the controller. the right side of the front panel contains two 
knobs to set the ratio between the monitor and the mix signal and the volume 
of the headphones.

Cue/Master Ratio   Headphones Level

Master Volume

•	 the cue/monitor buttons for each player. activating the cue button of a player 
sends the audio to the Headphones; the channel fader of the corresponding 
player does not need to be up for the audio to be heard.

•	 the two channel faders that control the volume of the two players.

•	 the cross fader that controls the ratio between the left player and the right 
player.	 If	 you	 use	U-MIX	CONTROL	PRO	 you	 can	 configure	 the	 shape	 of	 the	
cross fader curve with the knob on the rear panel of the controller from a quick 
cut for scratching or to a longer fade for mixing. 
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•	 a 3 band equalizer for each player to control the cut/boost of the three fre-
quency ranges and a Kill button for each range to complete cut it. the mixer 
sections of the u-mIX control pro and u-mIX control 2 controllers con-
tain dedicated encoders for the three frequency ranges of the equalizer. turn 
the	encoders	to	modify	the	equalization	of	your	media	file.	Treble,	medium	and	
bass can be adjusted with these knobs. press the encoder to completely cut the 
low,	mid	or	high	frequencies	of	your	media	file.

•	 a gain knob to set the gain level and a mute button to mute the audio of the 
corresponding player.

Internal Mixer Mode                                                                       External MIxer Mode

Equalizer/ 
Level Meter

Volume/Cue

Input Mode

Gain/Mute

Channel Fader      Cross Fader                                   Level Meter

Input Mode

In both mixer modes the mixer panels show the pre-fader level of the player. pre-
fader means that the position of the channel fader and the cross fader does not 
affect the level meter. 

again, in both mixer modes you can use the Sources button to select the Input 
mode. 

Recorder
the buttons in the recorder panel can be used to record your mix, to record the 
audio of the players, or to record both at the same time. more information about 
the recorder panel can be found in section “recording” on page 99

Browser and Preview Player
the Browser panel allows you to access the tracks in your collection and your 
itunes library. this panel offers some sophisticated search features so you can 
quickly	find	the	track	you	wish	to	play	next.	The	browser	is	explained	in	more	detail	
in chapter 7 on page 73 and onwards.

the preview player can be used to preview the track that is currently selected in 
the browser. you do not need to load a track into the preview player, simply press 
its play button. the audio from the preview player can be heard in your headphones 
if you use internal mixer mode. In external mixer mode the audio of the preview 
player	is	routed	to	the	audio	interface	port	configured	as	Output	3.
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6.2 Changing the Screen Layout
you can use the commands in the View menu or the corresponding keyboard 
shortcuts to change the layout of croSS DJ.

 

(Windows) (mac)

use the command Toggle Display Mode to toggle between Browser View and mix 
View. In Browser View the players and the mixer are hidden to allow easier and 
faster browsing in your collection and playlist. In mix View the players and the 
mixer are visible and the browser occupies the remaining space.

the Full Screen command does exactly what is says: it maximises the croSS DJ 
window so that it occupies the complete screen.
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and mixing  
your music

Before	you	can	play	and	mix	your	audio	files	with	CROSS	DJ,	the	files	should	be	
imported into the track collection. this chapter explains the basic steps that need 
to be done and will then show you how to mix two tracks with croSS DJ.

7.1 Importing Folders
perform the following steps to import an entire music folder or disc:

1 open the File menu and click Import Directory.

2	 Select	a	folder	or	a	drive	with	the	audio	files	you	wish	to	import.	Click	OK.

3 croSS DJ	will	import	all	audio	files	from	the	selected	drive	or	folder	and	its	
subfolders	into	the	collection.	Once	the	import	has	been	done,	the	files	are	
shown in the Collection view of the croSS DJ browser.

TIP	 If	 you	wish	 to	 import	a	single	file	only	or	a	group	of	files	 from	within	
one folder open the File menu, click Import File,	select	the	file/s	you	wish	to	
import and click Open.

to import a playlist in .m3u or .pls format open the File menu, click Import 
Playlist,	select	the	playlist	file	and	click	Open.

7.2 Importing Tracks from iTunes
If you use apple’s itunes® software to manage your track collection, you can ac-
cess your itunes® library and playlists by clicking on the itunes® tab in the Dock. 
perform the following steps to import tracks from itunes®:

1 click the itunes® icon in the browser dock to open your itunes 
library. (If the itunes® icon is not visible, right-click the dock and 
select itunes.)

2 Select the tracks you wish to import.

3 perform one of the following actions:

•	 Drag and drop your selection onto the collection icon in the dock.
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•	 right-click (ctrl-click on mac) the selection and choose Add to Collec-
tion from the context/action menu.

7.3 Importing Collections from other DJ Software
croSS DJ makes it easy to import collections and tracks from traktor, rekordbox, 
and	from	Virtual	DJ.	During	the	import	not	only	the	audio	files	are	imported,	but	
also any playlists that you have created in the supported third party applications. 
also imported is certain track information, like beatgrids, cue points and – if appli-
cable	–	the	first	loop	you	set	in	the	third	party	tool.

perform the following steps to import the collection from another DJ software:

1 open the File menu and select Import Third Party Database. croSS DJ 
opens	a	dialog	box	where	you	can	select	the	database	file	of	the	third	party	
application.

2	 Browse	to	the	folder	with	the	third	party	collection	file:

•	 to import a traktor collection, open the folder Native Instruments/
Trak tor x.x.x below your documents folder. x.x.x represents the trak-
tor version you are using. If you changed the default location of the 
collection	file	 (one	 the	Preferences/File Management tab), open this 
folder	instead.	Then	select	the	file	collection.nml. 

•	 to import a rekordbox playlist, open the folder where you exported the 
Rekordbox	playlist	information	to,	and	the	select	the	file	created	by	Re-
kordbox.

•	 to import a Virtual DJ database, open the folder VirtualDJ below your 
documents	folder	and	select	the	file	VirtualDJ Database vX.xml (X rep-
resents the version of the database format; the current version is 6). 

3 click Open to start the import process.

CROSS	DJ	will	import	all	audio	files	from	the	third	party	library	into	the	CROSS	DJ	
collection.	When	the	import	is	done,	you	will	find	all	audio	tracks	inside	the	Music 
node of the collection. 

If the imported collection contains playlists, croSS DJ will import them and create 
new entries directly below the playlists node. the traktor playlists can be found in 
the node Playlists/import-Traktor, the rekordbox playlists in the node Playlists/
import-Rekordbox, and the VirtualDJ playlists in the node Playlists/import-Vir-
tualDJ. you can drag and drop the imported playlists to a new position in the tree 
or rename them, if you wish to.
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Import of tracks that are already in the CROSS DJ Collection
If the imported collection contains a track that is already in your collection, croSS 
DJ	will	open	a	message	box	as	shown	in	the	following	figure:

•	 click Yes	if	you	wish	CROSS	DJ	to	read	the	tags	from	the	file;	these	tags	will	
replace the tags already in the croSS DJ collection. 

•	 click No, if you do not wish croSS DJ to keep the tags that are already in the 
croSS collection.

•	 activate the check box Do not ask me again if you wish that all imported tracks 
shall be handled in the same way as your current selection (yes/no). 

7.4 Analysing imported Files
the tracks in your collection need to be analyzed before croSS DJ can show the 
full track display and the transient view of the track in the Beat matcher. In order 
to use the automatic beat and cycle synchronisation croSS DJ provides, the Bpm 
and the beatgrid of the track also need to be analyzed. tracks that are not analyzed 
when you load them into the players are automatically analyzed. 

While the track is being analyzed, the text “ana-
lyzing” is shown in the full track display.

However, it is a good practise to trigger the analysis of newly imported tracks be-
fore you load them. the advantage of analysis before use is that the transient view 
and the full track display are available immediately after loading. If you load a track 
that has not yet been analyzed it can take a while until the full track display and 
the waveform in the Head-up Display are visible. also, as track analysis consumes 
cpu time it could lead to crackling sounds and this is something you do not want 
to hear during your set.

perform the following steps to analyze tracks:

1 make sure that the Collection tab is opened in the Browser.

2 Select the track/s you wish to analyze.

3 right-click the selection and open the Analyze menu. 
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4 Select one of the following options depending on what croSS is to analyze:

•	 Analyze all  use this option to analyze tracks that are added newly 
to the collection. During the analysis croSS will do a gain analysis to 
check, whether the signal strength needs to be raised or lowered when 
the track is played. furthermore, a peak analysis is done and the infor-
mation collected is used to display the waveform of the audio in the HuD 
and in the full track display on the player. then, the Bpm of the track is 
detected and croSS sets the beatgrid for the track. the beatgrid will 
help you to perform different kinds of beat sync operations (more to be 
found below).

•	 Analyze Beatgrid/BPM only  use this option to make croSS analyze 
the beatgrid and the Bpm of the track only. this option is very useful if 
you updated from croSS version 1.6 or lower to version 1.7 and higher. 
In general the gain and peaks of the tracks in your collection are already 
analyzed. to make use of the new sync features in version 1.7 you only 
need to perform a beatgrid/Bpm analysis.

•	 Analyze Gain only use this option to analyze the gain of the track only, 
in case you have changed the gain value of a track and want to restore it 
to the default, automatically analyzed value. 

•	 Analyze Peak only use this option to only analyze the peaks of the 
track. this is useful when you do not need the beatgrid or gain informa-
tion, maybe because you use timecode. 

A

 Have a look at column A. (short for analysis Status) and the column with the 
icons, the Status column to see which tracks have been analysed (a check 
mark	in	column	A.)	or	not.	 In	the	image	above	the	fifth	track	is	currently	
being analysed and 67% of the analysis is done.
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BPM Detection Range
Detecting the tempo of a track can sometimes be a bit tricky. croSS DJ performs 
a peak analysis to detect the beats, and then uses the data about the peaks to 
calculate the Bpm. as not all transients/peaks in a track need to be beats, you 
can “help” croSS DJ by setting the Bpm Detection range on the Preferences/ 
General dialog.

Use	the	range	that	best	fits	to	your	music	genre:	Slow is the best setting for Hip 
Hop, Standard is the best choice for House/techno, and you wish to set the range 
to Fast if you mainly spin Drum ’n’ Bass.

7.5 Using the Beatgrid Tools 
as you could see in the previous section, croSS DJ performs a Bpm and beat ana-
lysis:	both	values	are	used	to	define	the	initial	beatgrid	of	a	track.	The	beatgrid	is	
initial, because croSS offers several tools that you can use, to change the beatgrid 
if necessary.

Before we take a close look at the beatgrid tools of croSS DJ, we should start by 
defining	some	important	terms	and	have	a	look	at	the	visual	representation	of	the	
beatgrid as it is shown on the HuD and on the waveform of the players. 

NOTE In order to see the beatgrid, you need to activate the checkbox Show 
Beat Grids on the Display tab of the Preferences dialog. activating this op-
tion makes the grid visible on the HuD and on the waveform. of course, if no 
beatgrid has been analyzed, croSS DJ cannot show it. In this case use the 
command Analyze Beatgrid/BPM only as explained in the previous section.

the beatgrid information on the player is shown as vertical lines. a vertical line 
with	the	height	of	the	complete	waveform	represents	a	downbeat	(i.e.	the	first	beat	
of	a	4	beat	bar).	The	first	downbeat	gridline	that	you	see	on	the	waveform	serves	
as the reference point of the grid and is marked with yellow triangles at both end-
points. all vertical gridlines that are marked with white triangles at the endpoints 
represent another downbeat. the gridlines of the beatgrid have the same spacing 
as	CROSS	DJ	assumes	 that	 the	 tempo	of	 the	 track	 is	fixed	and	 that	 it	does	not	
change over the duration of the track. the following rules apply to the beatgrid: 
the greater the spacing of the individual gridlines, the lower the track tempo. the 
smaller the spacing, the higher the track tempo is.
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the individual beats, half beats and quarter beats of one bar are symbolized by 
shorter vertical lines. the number of shorter vertical lines that are visible depends 
on the current zoom factor of the waveform display on the player and the HuD. 
the more zoomed in you are, the more shorter lines are visible. the grid that was 
analyzed by croSS DJ is called the base grid. 

The Beatgrid Toolbar on the Player
the lower right corner of the player a and the lower left corner of player B contains 
the button Show/Hide Beatgrid editor. If you click the button to make the beatgrid 
editor visible, a toolbar is displayed in the lower area of the waveform. this toolbar 
contains all the buttons that you need, to make changes to the beatgrid.

When the Beatgrid toolbar is visible, croSS DJ changes the display of the grid-
lines on the player as well. as you can see in the following image, each beat is now 
represented by a vertical gridline with the same height of the waveform. these 
longer	grid	lines	make	it	easier	to	see,	whether	the	grid	fits	perfectly	to	the	track	
or not.

you can use the following buttons of the toolbar to change the active grid:

	 The	first	two	buttons	of	the	toolbar	can	be	used	to	expand	or	to	shrink	the	
distance between the gridlines. Shrinking the beat intervals increases the Bpm of 
the track: the gridlines are now closer to each other and this will lead to an incre-
ase in the tempo. expanding the beat intervals decreases the Bpm of the track: the 
gridlines are now further apart from each other and this will lead to a decrease in 
the tempo.
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 With these two buttons you can move	the	first	downbeat	(the	line	that	is	
used as the reference point of the grid) to the left or to the right. When this down-
beat is sitting at the right position (exactly on the transient) it makes it easier to use 
the automatic sync features of croSS DJ. It is a good practice to zoom into the 
waveform	before	you	move	the	first	downbeat/the	grid.	

 use this button to convert the beat closest to the current playback position 
into a new downbeat. the button Define Downbeat is only active if the track has a 
beatgrid; otherwise it is disabled. the new downbeat resets the cycle/bar/beat-
counter of the track. this is useful if you use the “sync to cycle” feature of croSS 
DJ. let’s have a look at an example track that shows how this works.

on the track in the following image a beatgrid analysis was performed. croSS 
DJ has set the downbeat at the very beginning of the track, even though the track 
starts	with	4	beats	=	1	bar	of	silence.	If	we	number	the	first	beats	of	this	track	with	
a Cycle.Bar.Beat schema, the counter for the beats is 1.1.1, 1.1.2, 1.1.3, 1.1.4, 1.2.1.

 

1.1.1   1.1.2   1.1.3   1.1.4   1.2.1

Because the track starts with 4 beats of silence, this numbering is wrong and does 
not	reflect	the	real	musical	structure	of	that	track.	The	fifth	beat,	which	is	the	first	
audible beat, should be 1.1.1. If you drag the waveform to this beat and click on 
Define Downbeat, croSS DJ adds a new downbeat marker to the grid (marked 
with the yellow triangles), and resets the internal beatcounter. 

1.1.1  1.1.2   1.1.3   1.1.4     1.2.1

the internal beatcounter that croSS DJ uses to automatically sync to the cycle/
bar/beat of the track in the other player, now has a correct value to do this syn-
chronisation.

	 If	the	configured	BPM	detection	range	does	not	fit	to	the	tempo	of	the	gen-
re, you often get Bpm values which are twice as large or half as small as the real 
tempo. to correct this kind of Bpm error, you can use these two buttons to halve or 
double the Bpm value of the currently loaded track. 

 to delete all beatgrid information, click the Clear Beatgrid button. When the 
track has no beatgrid, the button Analyze Beatgrid is shown. click this button to 
perform a Bpm and a beatgrid analysis. 
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Using User Beatgrids
Sometimes tracks do not use a strict 4/4 signature throughout the whole track. 
let’s assume you have a track with a beat length that cannot divided by 4 without a 
remainder, or another track with a tempo change where one part of the track has 
a different Bpm than the other. for those tracks you can add a user beatgrid. the 
number of additional user beatgrids that you can add is unlimited.

When you	add	a	user	grid	you	actually	set	the	position	of	a	new	downbeat	(the	first	
beat of a bar) and this downbeat can be set to any position of the track. 

 to set a user beatgrid, drag the waveform to the desired position and click the 
Add Beatgrid button on the Beatgrid editor toolbar. the new user beatgrid serves 
as the reference point of the grid from the position of the marker towards the end 
of the track. the waveform before the user beatgrid marker is shown in grey indi-
cating that this segment is not affected by the current downbeat marker. the 
waveform behind the user beatgrid marker is shown in yellow/red (depending on 
the player), indicating that this segment of the track is affected by the current 
downbeat marker.

Setting a new user beatgrid also resets the bar and beat counter value to 1. you 
can change the tempo of a new segment with the shrink/expand buttons only. each 
user beatgrid can have a different tempo.

 If you wish to delete a user beatgrid, drag the waveform and make sure, that 
the current playback position is behind the user beatgrid downbeat you wish to 
delete. then click the Delete Beatgrid button on the Beatgrid editor toolbar.

Section „a closer look at the Beat matcher“ auf Seite 82 in this manual will show 
you, how the beatgrid of the track will help you, to either manually or automatically 
synchronize the tracks in the two players.

7.6 Loading Tracks into the Players
once your audio tracks are imported into the collection you can load them into the 
players. Depending on your setup you can use the controller, the mouse or the 
keyboard to load tracks.
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Loading Tracks with U-MIX CONTROL PRO/U-MIX CONTROL 2
perform the following steps to select and load a track with the controller:

1 use the Browse encoder to scroll through your collection. or hold the Shift 
button and turn the Browse encoder to scroll by 10 tracks through your 
collection.

2 press Load A to load the selected track into player a, or press Load B to 
load it into player B.

If you use a different controller than u-mIX control pro/2, it will most likely 
have Browse and load controls as standard. please have a look at the manual of 
your	controller	or	at	the	PDF	file	documenting	the	MIDI	preset	of	your	controller	
(see page 30 for more information)

Loading Tracks with the Mouse
perform one of the following actions to select and load a track:

•	 Drag and drop a track from any of the tracklist types onto one of the players.

•	 Drag and drop a track from any of the tracklist types onto one of the waveforms 
in the beat matcher to load the track into the corresponding player.

•	 right-click (ctrl-click on mac) the track and select Load in Player/A, or Load 
in Player/B or Load in Player/Active.

NOTE the active player is the player where you can see the yellow (player 
a) or red (player B) bar at the very top of the player above the track title in the 
user interface. you can select which player is currently active by clicking an 
empty space on the player or by pressing the (ÿ) key.

Loading Tracks with the Keyboard
perform the following steps to select and load a track:

1 Hold (Ctrl) (Windows) or (cmd) (mac) and press (¼) and (½) to scroll 
through your collection and to select the track you wish to load.

2 Hold (Ctrl)+(ª) (Windows) or (ald)+(cmd) (mac). then press (æ) to load 
the track into player a or press (Æ) to load the track into player B.

NOTE By default croSS DJ/croSS DJ le loads the track completely into 
the memory of your computer for quick access, which puts some load on the 
CPU.	The	amount	of	memory	that	may	be	used	by	CROSS	DJ	can	be	config-
ured with the Audio Cache slider in Preferences/General. In most cases you 
will not need to change the default setting. If you prefer your tracks to be 
streamed	directly	from	the	audio	files,	set	the	Audio Cache slider to 0%.
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Loading into playing Decks
please note that the default security setting does not allow you to load a new track 
if a player is currently playing. this setting can be changed on the General tab of 
the Preferences dialog by deactivating the Security Mode checkbox. However, this 
setting can protect you from accidentally loading a track into the wrong player and 
it is best left activated.

7.7 Your First Mix
once you have some tracks imported into the collection you are ready for your 
first	mix.

1 load a track into player a.

2 press the Play button on the controller or click the Play button on the play-
er to start playback of the track in player a.

3 open the channel fader for player a.

•	 If you are using one of the u-mIX control controllers, move the vol-
ume fader for player a upwards. also make sure that the cross fader is 
in the middle position or at the outer left position.

•	 If you are using an external mixer, open the volume fader for the chan-
nel where you routed output 1 to.

•	 If you do not use a controller, use the mouse and move the volume fader 
in the mixer for player a upwards.

 you should now hear the music in your speakers. 

4 load your second track into player B and start playback of player B.

5 While the track on player a is playing to the public, press the cue/monitor 
button for player B. you now can pre-listen to the next track on player B in 
your headphones while the audience listens to the track being played on 
player a over the speakers. 

6 the tempo of the two tracks is most likely not the same. you need to match 
the tempo of both tracks, and synchronize the beats of player B to player a 
to get a smooth transition. use one or several of the following techniques 
and tools:

•	 adjust the tempo/Bpm of the new track to match the one that 
is currently playing by using the pitch fader.   
If you want croSS DJ to take care of the tempo adjustment click  
the match button on player B.   
If you use u-mIX control pro/ u-mIX control 2, hold the SHIft but-
ton on the controller and press the Sync button for player B.
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•	 once the two tracks are being played with the same Bpm, you need to 
make sure, that their beats match. 

you can achieve this by using pitch bend buttons on the user interface 
or the controller (see section “using the pitch controls” on page 88 for 
more information). the pitch bend buttons are also used for slowing 
down/speeding up the playback of a player temporarily. this shifts the 
playback position of the beats.

If you use u-mIX control pro/ u-mIX control 2 or another control-
ler with a jogwheel, use the jogwheel to perform the same action.

If you wish croSS to take care of the tempo and beat adjustment, click 
the Sync button on the player with the new track. on the u-mIX con-
trol pro/ u-mIX control 2, press the SYNC button for the player 
with the new track. 

Which action that is triggered by the Sync button depends on the Sync 
Mode setting that you can select in the General tab of the Preferences 
dialog. clicking sync always matches the tempo of the track to one or 
the other player, and either, syncs to the beat, the bar or the cycle of the 
other track. (See section „Sync-meters“ on page 84 for more informa-
tion about the sync modes.) 

•	 use the Beat matcher in combination with the Sync meters in the Head-
up Display as a visual indicator. the next section shows some examples 
of what you can read in the Beat matcher and how the Sync meters can 
help you to synchronize your tracks.

7 adjust the volume level by using the gain knob. the gain knob allows you to 
set the overall level to match that of the track playing on the other deck.

NOTE If you change the gain level of a track, croSS DJ stores the 
new	value	in	the	collection	file.	If	you	load	the	track	again,	the	changed	
gain setting is automatically applied.

8 to make the blend from one track to another, move the crossfader from left 
to right, or use the channels faders on your controller or external mixer.

9 you can also change the channel equalization of the mixer to make the 
transition between the two tracks more smoothly.

10 additionally you can use the effects and loops to highlight different parts of 
an audio track.

TIP If you are using the u-mIX control pro you can change the cross fad-
er curve on the rear panel on the controller. you can set the curve to a quick 
cut that is best for scratching to a longer fade, which is best for beat mixing.
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7.8 A closer Look at the Beat Matcher 
let’s have a closer look at the Beat matcher so we can understand what informa-
tion it provides and how it can assist you in achieving the synchronisation of two 
tracks.

the Beat matcher can display three different kinds of information: the peaks, the 
beatgrid and the sync meters.

Peaks of the Track
the peaks display in the Beat matcher shows a kind of level information of the 
tracks currently loaded in the players. the peaks view is always on and cannot be 
disabled. the peaks data is analyzed when you drag a new track onto one of the 
players, or when you select Analyze all or Analyze Peak only in the context menu 
for the tracks in the track browser.

In both waveforms you can see several vertical lines. these lines represent the 
peaks, or transients, in the track. Depending on the rhythm of the track, these 
peaks may be the beats of the track, but they may not always be where the beats 
are. the track in player a (upper waveform) shows some longer and some shorter 
peak lines. In most cases the longer lines are there where the beats are. the beats 
in player B are much more obvious; the part you see in the image is from the track 
intro which has a clear beat.

If you move the waveform of player B by pitch bending to get two peak lines aligned 
it becomes very clear, as you can see in the following image.

the larger distance between beats in player B implies that the tempo of that track 
is too slow compared with the track in player a. If you were to start playback of 
both tracks with the image above as a starting point, the beats would only match 
for a short period of time; quite soon the beats in player B will be heard later than 
the one in player a. to correct this you would need to raise the playback Bpm of 
player B.

the last image of the Beat matcher shows a situation where the tempo of both 
players is the same and where the beats are aligned: both tracks are now syn-
chronised. 
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However, the peaks view gives us no information whether the downbeat of the 
track in player a and the downbeat of the track in player B are audible at the same 
time. this information can be made visible by enabling the beatgrids for the Beat 
matcher.

Beatgrids of the Track
With the introduction of the beatgrid features you can additionally display the beat-
grid of the track on the HuD as well. to make the beatgrid visible, active option 
Show Beatgrids on the Display tab of the Preferences dialog. (please note, that 
this option makes the beatgrid visible on the HuD and on the waveform of the 
players.)

the long vertical lines with the yellow triangles at their endpoints represent the 
first	downbeat	of	a	4	bar	(=16	beats)	cycle.	All	other	long	vertical	lines	represent	
the	downbeat	of	bar	(i.e.	the	first	beat	of	a	4	beat	bar).	

the shorter lines that you see at the top and the bottom of the peak display repre-
sent either another beat or a fraction of one beat. the number of shorter lines that 
are shown varies depending on the zoom factor that you have set with the zoom 
slider at the right side of the Beat matcher.

Sync-Meters
a new feature are the two Sync meters on the HuD that you can enable with option 
Show Sync-Meters on the Display tab of the Preferences dialog. 

the Bar Sync meter at the left side informs you about the current playback position 
of a track related to one bar: for each beat in one bar one quarter segment of a cir-
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cle is drawn. the yellow meter shows the playback position of player a and the red 
meter shows the playback position of player B. as long as the playback position of 
both tracks are not in sync related the one bar, you see the two overlapping circles 
as	shown	in	the	following	figure:	

once both players are playing the same beat of a bar, then the bar sync meter 
draws	one	orange	circle.	This	is	shown	in	the	following	figure:

If you take a look at the peaks view (with beatgrid display enabled), you can see that 
the long vertical lines representing the downbeats are now vertically aligned. the 
bar sync meter and the peaks view show the same kind of information and you can 
decide which one you wish to use to get your tracks synchronized.

at the right side of the HuD you can see the cycle sync meter. the cycle sync meter 
shows whether the two tracks are playing the same beat of the same bar, in rela-
tion to a cycle of four bars/16 beats. Imagine a beatcounter that uses the following 
format to display the current playback position: cycle.Bar.Beat. If the playback 
position of player a is x.3.2 and the position of player B is x.3.4, then they are not in 
sync in relation to the bar and beat number. for this scenario the cycle meter will 
draw one yellow circle for the position of player a and one red circle for showing 
the position of player B. In the cycle meter each quarter segment represents one 
bar; this means that one full circle is equal to four bars.

once the number of the bar and the number of the beat of both players are same, 
then the cycle meter will draw one orange circle only. If the cycles of the two 
tracks are in sync, then the beats in a bar are also in sync. this means that the bar 
sync meter will draw an orange circle to.

the introduction of the three different synchronisation modes in croSS can help 
you, to get both tracks automatically synced.

Setting the Synchronisation Mode
If you press the Sync button on the players in croSS, the software always per-
formed a beat synchronisation; resulting in the beats in both tracks are played 
back at the same time.
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With the introduction of the beatgrid it is now possible to select between three dif-
ferent	synchronisations.	The	selected	sync	mode	defines	what	will	happen	when	
you press/click the Sync button. In order for this to work the tracks in both players 
do need a beatgrid.

You	can	configure	the	sync	mode	of	CROSS	by	opening	the	Preferences/General 
tab and select the desired mode in list Sync Mode:

•	 Beat If you select Beat mode, then pressing Sync only syncs to the other play-
er’s beat. Both tracks are then running beat or phase synchronous.

•	 Bar If you select Bar mode, then pressing Sync synchronizes the track in the 
player to the same beat number in a bar that is playing in the other player. Both 
tracks are running bar synchronous.

•	 Cycle If you select Cycle mode, then pressing Sync synchronizes the track in 
the current player to the same bar and the same beat number in a cycle that is 
playing in the other player. Both tracks are running cycle synchronous.

7.9 Customising the Players
You	can	customise	the	players	to	make	them	better	fit	to	your	needs.	Some	of	the	
options are available in the user interface.

Scroll Mode

Lead In

Waveform 
Zoom

Vinyl Mode/CD Mode

Waveform Zoom use the three buttons at the outer side of the waveform to zoom 
in, to zoom out and to reset the zoom to the default value.

Waveform Scroll Mode In the default setting the playback maker on the wave-
form	is	at	a	fixed	position	and	the	waveform	moves	underneath	it	during	playback.	
click the Waveform Scroll Mode button, if you want the playback marker to move 
and	the	waveform	to	be	fixed.

Vinyl Mode/CD Mode use this button to activate Vinyl mode. In Vinyl mode you 
can use the jogwheel of u-mIX control pro/u-mIX control 2 to scratch your 
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media. to activate Vinyl mode you can use the Vinyl button available on both con-
trollers as well, or use the (V) key, to toggle the Vinyl mode of the active player. 

more player related settings can be found on the General tab and on the Display 
tab of the Preferences dialog.

 

Lead In/Lead Out  use the two sliders Lead In and Lead Out on the General tab 
to set the length of the lead In and the lead out marker.

End of Track Alarm use this slider on the Display tab to set the remaining play 
time of a track, during which the full track display shall blink red to warn you, that 
you will soon reach the end of the track. 

7.10 Moving in a Track
you have several options to change the playback position of a track:

•	 click into the waveform or into the full track display. playback continues from 
where you clicked.

•	 use the jogwheel of u-mIX control pro/u-mIX control 2 to seek through 
the track as long as the track is not playing. Holding the SHIft button on the 
controller seeks through the track at a higher speed.

you can use the Smart Seek controls to perform a beat jump forward in a track. 
the Smart Seek controls reside in the transport section of the players. click the 
Smart Seek Length indicator to select the seek length (in beats or fractions of a 
beat). then click either on Smart Seek Backward or on Smart Seek Forward.

Smart Seek Length

Smart Seek Backward   Smart Seek Forward

the Smart Seek actions can be performed with the keyboard and with u-mIX con-
trol pro/u-mIX control 2 as well:
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Action U-MIX CONTROL Windows Mac OS X

Select length
 +  (press)

— —

Smart Seek 
Backward  +  (turn left)

(Alt)+(æ) (Alt)+(æ)

Smart Seek 
forward  +  (turn right)

(Alt)+(Æ) (Alt)+(Æ)

7.11 Using the Preview Player
If you have two tracks playing at the same time and are not sure, which track to 
play next, you can use the preview player to help make your selection. 

press the Play/Pause button to start playback of the track that is currently se-
lected in the browser. use the Seek slider to move through the track: the top of the 
slider represents the beginning of the track. 

Play/Pause

Seek through Track

Volume

the Volume knob allows you to change the volume level of the preview deck. If you 
use croSS DJ in internal mixer mode, the audio of the preview player is sent to 
the	Cue/Monitor	output	you	configured.	In	external	mixer	mode	you	would	need	a	
mixer with three channels and an audio interface with three stereo outputs, as the 
audio of the preview player is sent to the cue output, which is routed to the outputs 
configured	as	Output 3 (Preferences/Audio dialog).
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8/ 
organizing your 
music with the 
Browser

the lower part of the croSS DJ window contains the browser. you can use the 
browser to organize your music, to search for tracks and to create and use play-
lists.	You	can	use	the	following	audio	file	formats	with	CROSS	DJ/CROSS	DJ	LE:	
mp3, aIff, WaV, ogg, flac, m4a and aac.

Before	you	can	work	with	the	audio	files	in	the	browser	you	need	to	import	them	
into the collection. the steps for importing tracks are explained in the sections on 
page 63and onwards.

8.1 Overview of the Browser
the browser section of croSS DJ has two main panels: the dock panel and the 
browser panel itself. the dock and its buttons allow you to open quickly different 
views of your media. the main part of the browser section shows all media inside 
the list that you have selected by clicking its button in the dock.

8.2 The Dock
the dock is the central component of the track management as it allows you to 
open different views or different locations by clicking the corresponding button. 
the dock can be customized: you can add buttons, remove buttons and change 
their order.

By default the dock contains the following standard tabs:

• Collection opens the collection list. the collection list contains all tracks 
that you have added to your collection. additionally all your playlists and Smart-
lists reside here. 

the History node contains information about the sets you have previously 
played. the lists inside the History node are organized by year and month and 
you	will	find	a	playlist	for	each	session	inside	the	month	node.	You	can	change	
the naming pattern by opening the Preferences/General dialog and entering a 
new pattern into the text box History Node Naming Pattern. If you hover over 
the text box croSS DJ displays the placeholders that can be used in the pat-
tern.
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• Files  opens a list with all local and remote drives and folders of your com-
puter.

• iTunes opens the itunes library on your computer including all playlists that 
you have created in itunes.

• Prepare the Prepare button opens the prepare window which is a holding 
area for tracks, similarly to when a DJ sifts through records in a record bag. 
you can use the prepare window to either prepare a set or to add tracks that 
you may wish to play through the course of your gig. you can drag tracks or 
complete folders from the track browser onto the Prepare icon in the dock. to 
create a playlist from your prepare list, right-click the tracks and select Add 
to New Playlist.

• Autoplay the autoplay list is a special playlist and can be used to let croSS 
DJ mix the tracks for you. more information can be found on page 101.

Organizing and Customizing the Dock
the dock can be customized in various ways:

•	 Drag a button in the dock to a new position if you wish to change the display 
order of the buttons.

•	 Drag a button out of the dock to remove it.

•	 right-click on the dock to open the context menu. 

•	 the upper part of the context menu contains all default lists. click on a menu 
entry to show/hide the corresponding button in the dock.

•	 The	lower	part	of	the	context	menu	contains	all	user-defined	entries/lists.	Click	
the name of an entry to remove its button from the dock.

•	 Drag any playlist, smartlist or folder from the browser tree and drop it on the 
desired	position	on	the	dock	to	add	a	user-defined	button.
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8.3 The Browser Panel
In the default setting the browser area contains a tree view and a list view of the 
element you opened by clicking its button in the dock. 

Album Browser On/Off 
Column Browser On/Off        

              
Dock               TreeView     

the list that is shown at the right side of the browser panel contains all tracks of 
the currently selected folder, playlist, or any other element that has been selected 
in the treeview. When a track contains meta information, those are shown in the 
list.	If	no	meta	information	is	available	then	the	filename	is	shown.

You	have	several	options	to	change	and	configure	the	list	view:

• Sorting the list click on one of the column headers to sort the list by this 
column. the label of the clicked column will then contain a little arrow showing 
the sort order (ascending/descending).

• Selecting columns right-/ctrl-click on the name of one of the columns. 
croSS DJ opens a list with all available columns. click the name of the column 
you wish to show/hide.

• Changing the order of the columns click one of the column headers and drag 
it to another position to change the order of the columns.

The	first	column	titled	A.	that	you	see	in	the	previous	figure	informs	you	about	the	
analysis status of the track. Here you will see a question mark if the track is not yet 
analysed. a check mark tells you that analysis has been done.

the second column indicates the quality of the track by the following icons:
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Icon Quality AAC MP3, WAV, AIFF etc.

perfect Bitrate >= 256 kbps Bitrate >= 320 kbps

great Bitrate >= 192 kbps Bitrate >= 256 kbps

good Bitrate >= 160 kbps Bitrate >= 192 kbps

average Bitrate >= 96 kbps Bitrate >= 128 kbps

poor Bitrate >= 64 kbps Bitrate >= 96 kbps

Buggy Bitrate < 64 kbps Bitrate < 96 kbps

the third column from the previous browser image contains information about the 
status of the track. Here you can see if the track is loaded into player a or player 
B, if the track has been played after you have launched cross or the status of the 
track analysis and if the track is currently being analysed.

The Title Bar
the title bar shows the current node name, the number of tracks, and it contains 
the	search	field	and	two	buttons	to	open	and	close	additional	panels.	

The Column Browser
click the Column Browser button in the title bar to open the column Browser pan-
el. In the default setting the column browser groups the tracks by three different 
properties	that	CROSS	DJ	extracts	from	the	media	files:	Genre,	Artist	and	Album.	
You	can	refine	and	filter	 the	 list	view	by	clicking	an	entry	 in	any	of	 the	property	
lists. to remove a property selection, click the X in the title bar of the property list.

right-click any of the title bars to open the Visible Properties menu. Here you can 
select another property for that list or you can click on Default to return to the 
standard setting with the genre, artist and album properties. you can drag and 
drop the property header to change the order of the browsing columns.
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The Album Browser
If is easier for you to remember an album cover than the track name or artist, 
you can open the album Browser by clicking the third button in the title bar. If the 
column Browser is currently open, the attributes and the album covers also serve 
as	filters.	To	see	all	album	covers	you	either	need	to	close	the	Column	Browser	or	
to deselect all currently activated properties. If you click on one of the covers, all 
tracks of the selected album are shown in the list.

8.4 Searching for Tracks
Another	way	other	than	using	the	filter	functionality	of	the	Columns	Browser	and	
album Browser is entering the search criteria direct into the Search	field,	that	sits	
at the right side of the title bar. entering search words triggers a dynamic search 
in your collection, i.e. croSS DJ displays all tracks found that match the search 
criteria entered so far.

In the default setting croSS DJ searches in the album, artist, genre and title 
properties of your tracks. you can change the properties that croSS DJ should 
search in by clicking on the magnifying glass at the left side the Search	field;	this	
opens the Active Properties menu.
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•	 click on one of the properties, to include/exclude it from the search.

•	 click on All to have croSS DJ search in all available properties.

•	 click on Default to restore the default property selection that is shown in the 
previous image.

8.5 Using Playlists and Playlist Folders 
playlists can help you to prepare for a gig or to organize your music collection. you 
can create playlists from scratch or use the playlists that you may have already 
made in itunes. playlists are created in the playlists node of your collection. as 
with itunes, this node can contain folders as well as playlists. this makes it pos-
sible to organise playlists hierarchically. 

Creating Folders 
to create a playlist folder, follow these steps:

1 click the Collection button in the dock.

2 If you wish to create a folder at the highest level right-/ctrl-click the Play-
lists node. If you wish to create a folder at a lower level right-/ctrl-click the 
parent folder.

3 Select Create New Folder from the context menu.

 a new folder with the name “untitled folder” is created and the name is 
selected.

4 enter the desired folder name and press [¢].

,
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NOTE If you want to change the name of an existing folder, double-click the 
name to enter edit mode, make your changes and press [¢].

Creating an Empty Playlist
to create an empty playlist, follow these steps:

1 click the Collection button in the dock.

2 open the Playlists node if necessary.

3 If the new playlist is to reside in Playlists node, right-/ctrl-click node. If 
you wish to create the playlist inside a playlist folder, right-/ctrl-click this 
folder.

4 Select create new playlist in the context/action menu.

 a new playlist with the name “untitled playlist” is created and the name is 
selected.

5 enter the desired playlist name and press [¢].

NOTE If you wish to change the name of an existing playlist, double-click its 
name to enter edit mode, make your changes and press [¢].

Creating a Playlist from inside the Listview
If you are currently in listview and see some tracks that should be at the beginning 
of a new playlist, proceed as follows:

1 Select the track or tracks in listview.

2 right-click the selection and choose Add to new Playlist. croSS DJ opens 
the following window:

3 enter a name for the playlist and click OK.

 the new playlist is created and the selected tracks are added to the playlist.
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Importing a Playlist from iTunes
If you have already created a playlist in itunes you can import the list easily into 
croSS DJ by proceeding as follows:

1 click the iTunes button in the dock.

2 right-/ctrl-click the itunes playlist that you wish to import.

3 Select Export to Playlists to put the playlist directly below the croSS DJ 
Playlists node. 

 or:

 Select Export to Playlists Folder and select the folder to where the itunes 
playlist shall be exported.

Adding, moving and deleting Tracks
tracks can be added to a playlist by selecting them in the listview, then by drag-
ging them onto the playlists’ icon in the treeview. If you have added a playlist but-
ton for the target playlist to the dock, you can drag and drop the selected tracks 
onto this button. 

another way to add tracks to a playlist is by using the context menu in listview. 
Select the track/s you want to add to an existing playlist. then right-/ctrl-click the 
selection. click Add to Playlist and then select the desired playlist in the submenu 
of this command.

new tracks are always added at the end of the playlist. to change the order of the 
tracks in a playlist use drag & drop. 

to delete a track from a playlist, right-/ctrl-click the track and choose Remove 
from Playlist.

8.6 Using Smartlists
Smartlists	are	another	useful	feature	that	helps	you	organizing	and	finding	your	
tracks.	Smartlists	are	filters	that	are	applied	to	your	collection.	A	smartlist	filter	
can contain one or more conditions. most of the conditions that can be used query 
the meta information of your tracks, like the title, artist or tempo. other conditions 
query data that is stored in your collection, like the date the track was added, for 
example.

CROSS	DJ/CROSS	DJ	LE	contains	 several	 pre-defined	smartlists.	 To	 see	which	
smartlists are available, click the Collection button in the dock and then open the 
Smartlists node in the treeview. 
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Click	on	one	of	the	smartlist	names.	The	filter	contained	in	the	smartlist	defini-
tion is applied to your collection and the resulting tracks are shown in the listview 
panel of the browser.

Let’s	have	a	look	at	the	inside	of	one	of	the	pre-defined	smartlists.	This	will	help	
you	to	define	your	own	smartlists.

1 right-/ctrl-click on the smartlist 115–135 BPM.

2 click Edit in the contextmenu.

 croSS DJ opens the panel with the smartlist editor.
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 Filter Type: ALL or ANY

 Have a look at the title bar of the smartlist editor. the title reads “match 
all of the following search criteria”. croSS DJ supports two different 
types	of	smartlist	filters.	For	the	type	that	is	used	here,	all	of	the	defined	
search criteria must be met for a track to be displayed in the search re-
sults.

 for the second type you will read “match any of the following search crite-
ria”	in	the	title	bar.	With	this	type	only	one	of	the	defined	conditions	must	be	
met for a track to be displayed in the search results.

 You	can	simply	change	the	filter	type	by	clicking	the	title	bar	of	the	smartlist	
editor.

 Standard Options for Smartlists

 The	first	three	rows	shown	in	the	previous	figure	are	standard	options	that	
are available in all smartlists. the checkbox at the very beginning of the 
row must be activated; otherwise the option is not applied.

 activate Auto Refresh if croSS DJ is to update the search results while you 
are	defining	the	search	criteria.	If	Auto Refresh is deactivated, the search 
results will not update until the next time the smartlist is opened. 

 you can use the second row, Limit to, to limit the search results. as well as 
the	number	of	tracks,	you	can	set	a	limit	by	file	size	(in	MB	or	GB),	or	you	
can	define	a	limit	of	the	total	playing	time	of	the	tracks	(either	specified	in	
minutes	or	hours).	You	define	a	limit	by	opening	the	list	box	to	select	the	
criteria. then enter the desired value into the text box of that row.

3 change the number of tracks from 25 to 40.

4 the last standard option is the sort order. open the list box Ordered by in 
the third row to get an idea of the available options.
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5 all other rows contain the criteria that shall be used for this smartlist. In 
this example the Bpm of the track shall be used, and the Bpm must be in 
the range from 115 to 135. open the listbox where currently BPM is se-
lected	to	get	an	idea	of	the	information	fields	that	can	be	used.

6 click the button with the Plus sign in the title bar of the smartlist editor. a 
new	row	is	added	at	the	bottom	of	the	editor.	We	want	to	refine	this	smart-
list	and	add	a	criteria	that	filters	all	House	tracks.

7	 Open	the	first	listbox	and	select	Genre.

8 open the second listbox and select is.

9 open the third listbox and select House.

 If there are tracks in your collection that meet both criteria they are now 
shown in the listview.

10	 Click	the	title	bar	to	change	the	filter	type	from	ALL	to	ANY.

 now the listview will show all tracks where the genre is house or where 
the	BPM	of	the	track	is	inside	the	defined	range.

11 click the Minus button in front of the Genre row. the row is deleted.

12 click the OK button in the title bar to close the smartlist editor.

NOTE the button with the x in the title bar of the smartlist editor removes 
all criteria. 
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Creating a New Smartlist
Smartlists are created in a similar way as playlists. 

1 opening the collection by clicking the Collection button in the dock.

2 right-/ctrl-click the Smartlists node and select Create New Smartlist if 
you wish to create a new smartlist. croSS DJ creates a new smartlist with 
the name “untitled Smartlist”. the name is selected and you can edit it.

NOTE	 If	you	wish	to	create	a	new	folder	node	first,	click	Create New 
Folder and then use the command to create a new smartlist.

3 enter the desired name for the new smartlist and press (¢).

4	 Define	the	criteria	for	the	new	smartlist	as	shown	in	the	previous	section.

8.7 Viewing and Editing Track Meta Information
Most	of	the	audio	file	formats	that	can	be	used	with	CROSS	DJ	allow	the	storage	
of	meta	information	about	the	file,	like	the	artist	or	the	release	date	of	a	track.	You	
can view and edit this meta information in either listview or in the Info panel of 
the browser. 

CROSS	DJ	can	write	the	changes	you	make	either	to	the	collection	file	only,	or	to	
the	collection	file	and	to	the	tags	of	your	audio	track.	You	can	configure	whether	
CROSS	DJ	shall	write	the	changes	to	the	file	tags	or	not	on	the	Preferences/Gen-
eral dialog by checking or un-checking the option Do not save changes in Tags.

To	make	changes	 in	Listview	double-click	 the	field	you	want	 to	edit,	enter	 your	
changes and press (¢).	Some	of	the	fields	in	Listview	provide	a	listbox	where	you	
can	select	one	of	the	options.	Other	fields,	like	the	audio	format,	are	static,	and	
cannot be changed.

another option is to use the Info panel of the browser to see all available informa-
tion	about	a	track	and	to	make	changes	to	a	track.	Select	the	file	you	want	to	edit	
and click the Info button in the tool dock at the right side of the browser area.
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the information about the selected track is grouped in categories. click one of the 
category names to see detailed information about this category. please note that 
like	in	Listview,	not	all	fields	can	be	edited.

you can use the Info panel to add a cover image to a track. click the ellipsis button, 
select	the	image	file,	and	click	Open. If you want to delete a cover image, click the 
Delete button (with the x) that is visible below the cover art.

As	well	as	 the	“standard”	 tags	 for	audio	files,	CROSS	DJ	allows	you	to	attach	a	
colour category to a track. click the grey square in the Labels section (or click the 
corresponding square in listview), to open a listbox with the colours available. you 
could use one colour for warming up tracks, another colour for peak-time tracks 
or whatever kind of category you need.

8.8 Locating Missing Tracks
If	you	move	tracks	from	one	folder	to	another	or	if	you	have	changed	the	filename	
of	a	file	that	is	already	in	the	collection,	CROSS	DJ	will	no	longer	be	able	to	find	the	
track. the Status column in the listview then shows a red warning icon, like the 
one you see in the following image. 
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right-/ctrl-click this row and select Relocate from the context menu. Browse to 
the	new	file	location,	select	the	audio	file	and	click	Open.

If there is more than one track missing it is easier to use the missing tracks re-
solver: open the File menu and click Resolve all missing tracks. the Missing 
Tracks Resolver window is opened. 

Select	the	file	you	wish	to	relocate,	click	Relocate and browse to the new location 
of	the	file.	If	you	can	no	longer	find	the	missing	files,	click	Remove to delete the 
file	from	the	collection.

8.9 Using more than one Collection
In	the	default	setting	you	will	organize	your	tracks	and	audio	files	by	using	one	col-
lection.	However,	if	you	use	a	great	number	of	audio	files,	and	if	want	to	organize	
them	into	different	collection	files,	you	can	do	this	easily.

Creating a new Collection
follow these steps to create a new collection:

1 open the File menu and click on Create Collection, or press the shortcut 
(Ctrl]+[N) (Windows) or (cmd]+[N) (mac). The Save new collection to di-
alog is opened.

2 enter the name of the new collection.

3 click Save.

 the new collection is created. croSS DJ will open the new collection auto-
matically.
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TIP If you wish to save the open collection with a different name, open the 
File menu, click Save collection as	and	enter	the	new	filename	for	the	cur-
rent collection

Opening another Collection
perform one of the following actions to open another collection:

•	 open the File menu, click on Recent Collections and click on the name of the 
collection, you wish to open.

•	 open the File menu and click on Open Collection or press the shortcut 
(Ctrl]+[O) (Windows) or (cmd]+[O)	(Mac).	Select	the	collection	file	in	the	Open 
dialog and click Open.

NOTE	 On	launch,	CROSS	DJ	will	automatically	open	the	collection	file	that	
was last used. 

8.10 Optimizing the Collection Database
croSS DJ stores all tracks and all playlists of your collection are stored in a data-
base	file.	When	you	make	bigger	changes	to	your	collection,	for	example	deleting	
multiple	 files,	 the	 database	 file	 can	 become	 fragmented.	 If	 the	 database	 file	 is	
fragmented it takes a bit longer to access your collection. 

you can defragment and optimize your collection by opening the File menu and 
selecting Optimize collection.
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9.1 Using the Pitch Controls
each croSS player has its own pitch fader that works in a similar way as the pitch 
faders you know from a turntable or cDJ player. the main difference of the croSS 
pitch faders is that they offer three different pitch modes: Speed, tempo and Hy-
brid. 

Selecting the Pitch Mode
perform one of the following actions to set the pitch mode:

•	 click the Mode button in the upper part of the pitch section. the mode button is 
labelled with the currently selected pitch mode (i.e. Speed, tempo, or Hybrid).

•	 If you are using the u-mIX control 2 or u-mIX control pro controller 
press the mode button above the pitch fader. 

•	 press (ÿ) to switch to the player; then press (P).

What are the differences between the three pitch modes:

• Speed In Speed mode you can change the pitch like you would do with a nor-
mal DJ turntable. changing the tempo of the player changes the pitch of the 
audio as well. 

• Tempo In tempo mode you can change the playback tempo with-
out affecting the tone pitch. the tempo mode thus has a similar effect 
as the master tempo mode that is available with several cDJ-players.   
In tempo mode croSS uses a time stretching engine, which allows playback 
of audio at different tempos without changing the tonal key. When tempo mode 
is activated, the pitch fader is no longer a pitch fader but more a tempo fader, 
because a tempo change will not affect the pitch.

•	 Hybrid Hybrid mode is a combination of Speed and tempo mode as it consid-
ers the percentage speed change.

-100%        -66%             -33%               0%            +33%            +66%           +100%

Tempo  
Mode

Speed 
Mode

Smooth 
Transitions 

Speed 
Mode

Smooth 
Transitions 
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In the range from –33% to +33% the fader behaves like tempo mode. 
Below -66% and above +66% the fader behaves like Speed mode. 
In the range from –66% to -33% and between +33% to +66% the pitch is gradu-
ally increased or decreased to smooth the pitch transitions. this mode deliv-
ers great results as you get the best from Speed mode and tempo mode. the 
sounds stays more natural at extreme speed values, and you have a wide con-
stant-pitch range around 0% speed.

If one of the modes that provide the key locking is activated, then the Key lock icon 
at the side of the waveform is highlighted.

Changing the Tempo with the Pitch Fader 
you can use the pitch faders or the plus, minus and reset button in the pitch sec-
tion of the player to change the playback tempo. the pitch range can be set with 
the Range button on the pitch section. If you use either u-mIX control pro or 
u-mIX control 2 hold the SHIft button and press the moDe button to change 
the range of the pitch slider.

Click to change  
Pitch range

Reset Tempo
Decrease Tempo

Increase Tempo

CROSS	offers	five	different	ranges	and	the	range	can	be	set	individually	for	each	
player. for example, if you select 16% and if the original tempo of a track in a play-
er is 125 Bpm, then you can increase or reduce the tempo maximum by 20 Bpm. 

the minus and plus buttons next to the pitch fader can be used to change the 
tempo stepwise. the tempo is changed in smaller increments if you hold the (ª) 
key while clicking the button; you get larger increments if you hold the (ctrl) key. 
click the reset button (or press (ª)+(0))to set the tempo back to the original Bpm 
of the track. 

The	two	tempo	fields	below	the	Pitch	section	always	show	the	current	tempo	as	
Bpm value and the percentage difference to the original Bpm: 

Pitch Bending
two of the buttons in the pitch section can be used for pitch bending. these but-
tons temporarily slow down ( ) or speed up the tempo ( ). 
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as soon as the buttons are released the previous tempo is restored. this corre-
sponds to nudging a spinning record on a turntable and to the two pitch bend but-
tons found on cDJs. on a technical level pitch bending is used to move the phase of 
a player. you may need this to get the beats of two tracks in sync, once they playing 
at the same tempo.

the acceleration and deceleration factor is always relative to the current tempo 
of	 the	deck.	CROSS	DJ	provides	options	 to	configure	 three	different	percentage	
values,	fine,	normal	and	coarse	which	allow	you	to	pitch	bend.

Follow	these	steps	to	configure	the	three	pitch	bend	factors:

1 go to the menu and click File/Preferences. make sure that the General tab 
is open 

2 use the three sliders to set the set the pitch bend factors for the different 
ranges. please note: the factor for fine pitch Bend must be smaller than 
the one for normal pitch Bend and the factor for normal pitch Bend must 
be smaller than the one for coarse pitch Bend.

pitch bending can be done with the u-mIX control controllers, in the croSS 
players with the mouse and with keyboard shortcuts, as the following table shows.

Action U-MIX CONTROL Player/Mouse Keyboard

normal up 
(D)

normal Down
(E)

fine up
+

(ª)+ (ª)+(D)

fine Down
+ (ª)+ (ª)+(E)

coarse up – (Ctrl)/(cmd)+ (Ctrl)/(cmd)+(D)

coarse Down – (Ctrl)/(cmd)+ (Ctrl)/(cmd)+(E)
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9.2 Snapping Loops, Locators and Cue Points
With the beatgrid feature loops, locators, and cue points can be set either at the 
current playback position or they can automatically snap to the next beat, next 1/2 
beat, next 1/4 beat or next 1/8 beat of the tracks’ beatgrid.

to enable the snap feature for one of the players, click the Snap button on the 
player. you can set the snap value by clicking the Snap Length indicator next to 
the Snap button.

croSS DJ stores the status of the Snap button when you exit croSS DJ and res-
tores it on the next launch.

9.3 Looping
CROSS	DJ	allows	you	to	set	loops	in	your	tracks	on	the	fly.	You	can	either	use	the	
automatic	loop	feature	with	one	of	the	predefined	standard	loop	sizes	or	you	create	
manual loops by setting the loop In point and the loop out point.

Automatic Loops Manual Loops

Loop Activation

Using Automatic Loops
each croSS player contains a loop section below the waveform. you can use the 
loop section to set the length of automatic loops and to activate the loop at the 
same time. croSS provides several default loop sizes, ranging from 1/8 beat up 
to 16 beats. 

follow these steps to create an automatic loop:

1 make sure that the loop section is visible below the player. If you cannot see 
the loop section drag the separator line below the players to make space 
for the loop section.

2 perform one of the following actions:

•	 click the button with the desired loop length.

•	 press (ÿ) to activate the player with the track you wish to set the loop. 
press (J) and (K) until the button with the desired loop length is high-
lighted with a frame. press (U) to activate the auto loop.

•	 turn the loop encoder on the u-mIX control controller to select the 
desired loop length. press the loop encoder to activate the loop.
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TURN: Select Loop Length 
PRESS: Activate/deactivate Loop

 croSS sets the loop start point at the current position of the playback 
marker, if Snap is disabled, or snaps it to the currently selected snap 
length, if Snap is enabled. then the loop is activated. 

 the button with the selected loop length is highlighted. the loop button in 
the loop section is highlighted as well, showing you that a loop is active. 

 on the waveform the section of the track that is looped is highlighted with a 
white triangle. In the full track display the looped part is shown in a bright 
colour and the rest of the track in a dark colour.

3 While the loop is active you can:

•	 change the loop length, by using the (J) and (K) keys, or by clicking one 
of the other buttons in the loop control, or by turning the loop encoder 
on your u-mIX control controller.

•	 Deactivate the loop either by using the (L) key, or by clicking the Loop 
button or by pressing the loop encoder on your u-mIX control. 

Using Manual Loops 
the length of manual loops can be set as needed. to create a manual loop you 
need	to	define	a	loop	in	point	as	well	as	a	loop	out	point.

1 move the waveform to the position of the desired loop in point, or wait until 
playback reaches the position, where the loop in point shall be set.

2 click the In button or press the (I) key.

3 move the waveform to the position of the desired loop out point, or wait until 
playback reaches the position, where the loop in point shall be set.
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4 click the Out button or press the (O) key.

 the looped section of the track is marked in the waveform and in the full 
track display. additionally the loop is activated: the loop button is now 
highlighted.

once they are created manual loops behave in the same way as automatic loops. 
to change the loop size of a manual loop you can either set a new loop out point or 
move the current one. this is explained in the next section.

Moving the Loop
Sometimes	you	will	find	that	the	loop	is	not	exactly	where	you	want	it.	The	Smart	
Seek feature of croSS DJ makes it easy to move an activated loop:

1	 First	you	need	to	define	the	Jump	length	by	performing	one	of	the	following	
actions:

•	 click the Smart Seek length display until the desired jump length is 
shown.

•	 Hold the SHIft button on your u-mIX control controller and press the 
loop encoder until the desired jump length is shown in the Smart Seek 
length display.

2 now you can move the loop by performing one of the following actions:

•	 click the Smart Seek Backward or the Smart Seek forward button.

•	 press (Alt)+(æ) to move the loop towards the begin of the track or 
press (Alt)+(Æ) to move it towards the end of the track 

•	 Hold the SHIft button on your u-mIX control controller and turn the 
loop encoder.

TIP use the loop feature together with the locators that are explained in the 
next section: set a locator at a point that you want to use as the loop in point, 
jump	to	that	locator	and	finally	use	one	of	the	auto	loop	buttons	to	activate	
the loop.

9.3 Using Cue Points 
If	you	load	a	track	for	the	first	time,	CROSS	DJ	will	create	a	cue	point	at	the	begin-
ning of the track. the cue point is symbolised on the waveform and in the full track 
display	by	a	cue	marker,	which	looks	a	little	bit	like	a	flag	on	a	flagstaff.	
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Cue/Stop           Cue/Play

you can use the cue/Stop and cue/play button to start the playback at the position 
of the cue point and to set the cue point position.

Setting the Cue Point 
use the Snap button and the Snap Length selector on the player to enable/disable 
the Snap feature. then perform one of the following actions to set the position of 
the cue point::

•	 click the Cue/Stop button while the track is paused.

•	 press the shortcut (ª)+(C).

•	 Hold the SHIFT button on u-mIX control pro/u-mIX control 2 
and press the CUE button while the track is playing. When the player is paused 
press the CUE button. (note: SHIFT+CUE also works.)

TIP	 The	last	cue	point	that	you	set	in	a	track	is	stored	in	the	peak	files	au-
tomatically.

Jumping to Cue Point and start Playback 
perform one of the following actions to jump to the cue point and to start playback:

•	 click the Cue/Play button.

•	 press the (¢) key.

•	 Hold the SHIFT button and press PLAY/PAUSE on u-mIX control 
pro/u-mIX control 2 to activate cue/play from the controller.

•	 Hold the CUE button and press the PLAY/PAUSE button on u-mIX control 
pro/u-mIX control 2. playback will continue when you release both buttons.
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Jumping to Cue Point and start Playback temporarily 
perform one of the following actions to jump to the cue point and to start playback. 
all actions set the play marker to the cue point position. the track is playing as 
long as the button/key is pressed. If you release the button/key, playback is paused 
and the play marker is set to the cue point position again. 

•	 click the Cue/Stop button while the track is playing. 

•	 press the shortcut (C), while the track is playing.

•	 press the CUE button on u-mIX control pro/u-mIX control 2 while the 
track is playing. 

9.4 Using Locators (Hot Cues)
Several of the professional cDJ players allow you to store cue points in a track 
either on a memory card or in the memory integrated into the cDJ player. you can 
jump to a stored cue point – sometimes called hot cue – by pressing a button on 
the cDJ player.

croSS DJ allows you to store cue points as well; stored cue points are called loca-
tors. Below the two players you can see the locator section that informs you of the 
number and the position of the locators in the currently loaded track.

Locator Section

Locator Markers

Setting Locators and Jumping to Locators
perform the following steps to set a locator:

1 Set the playback marker to the position where you wish to set the locator or 
wait until playback reaches the desired locator position. 
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2 perform one of the following steps. please note that you can set a locator 
only if the locator button is not yet used:

•	 click Loc 1 to set locator 1, Loc 2 to set locator 2 etc. 

•	 use the (ÿ) key to set the focus to the player where the you wish to 
delete a locator. press (1) to set locator 1, (2) to set locator 2 etc. 

•	 press one of the locator buttons 1, 2, 3 on your u-mIX control to set 
locator 1, 2, or 3. press the SELECT button, and then press one of the 
locator buttons 1, 2, 3 to set locator 4, 5, or 6.

 the position of the locator (time) is shown on the locator button in the play-
er.

the same keys/buttons can be used to jump to a locator, once it is set. 

Toggle between Locators 1-3 and Locators 4-6

BUTTON ONLY: Set/Select Locator 
SHIFT+BUTTON: Delete Locator

Deleting Locators
perform one of the following actions to delete a locator:

•	 click the Delete button (with the X) next to the locator that you wish to delete.

•	 use the (ÿ) key to set the focus to the player where you wish to delete a loca-
tor. press (ª)+(1) to delete locator 1, (ª)+(1) to delete locator 2 etc.

•	 Hold the SHIFT button and press one of the locator buttons 1, 2, 3 on your  
u-mIX control to delete locator 1, 2, or 3. press the Select button, hold the 
SHIFT button and then press one of the locator buttons 1, 2, 3 to delete locator 
4, 5, or 6.

9.5 Effects
each of the croSS DJ players has its own dedicated fX section, where you can 
select the effect, switch it on and set all effect parameters with one knob. also 
the u-mIX control pro/u-mIX control have two fX sections with one push 
encoder and one knob each. this makes using the effects very easy.
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Push: FX On/Off 
Turn:  Dry/Wet 
            Effect Parameters

Select Effect

Select Effect

FX On/Off              Dry/Wet, FX Parameters

to use an effect perform the following steps:

1 Select the effect by opening the Effect dropdown list and click the name of 
the effect. on your u-mIX control turn the FX SELECT knob until the ef-
fect name is shown in the fX section of the player.

2 If you wish to fade the effect signal into your mix, make sure that the 
AMOUNT knob is at the min position.

3 click the FX On/Off button on the player or press the FX SELECT encoder 
on your u-mIX control to activate the effect.

4 turn the AMOUNT knob clock wise to make the effect signal and to change 
the	effect	specific	parameters.

the AMOUNT knob controls the dry/wet ratio and the effect parameters. the com-
mon behaviour of the amount knob is, that at the min position only the dry signal 
(the original signal from the player) can be heard.

the following sections give you more background information about the various 
parameters, that the amount knob changes. to better understand this section, 
you may wish to load some tracks and play with the effects, while you are reading.

Low-Pass
Low-Pass	is	a	Low-Pass	filter	(=	High-Cut	filter)	that	dampens	the	high	frequen-
cies,	i.e.	the	low	and	the	middle	frequencies	can	pass	through	the	filter.

The	Amount	knob	controls	the	following	filter	parameters:

•	 In	the	first	quarter	range	of	the	knob	the	dry/wet	ratio	 increases	up	to	100%	
wet; the ratio stays at 100% in the remaining range of the knob.
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•	 The	cut-off	frequency	of	the	filter	starts	at	14	kHz	and	goes	down	to	approxi-
mately 300 Hz the more you turn the amount knob clockwise.

•	 The	filter	resonance	starts	at	70%	and	goes	down	to	0%	the	more	you	turn	the	
amount knob clockwise. the resonance values are equally distributed over the 
amount range.

Hi-Pass
Hi-Pass	is	a	High-Pass	filter	(=	Low-Cut	filter),	which	dampens	low	frequencies,	
i.e.	the	middle	and	the	high	frequencies	can	pass	through	the	filter.	

the parameters for Hi-pass that are set with the amount knob are:

•	 the dry/wet ratio is always 100% wet, except at amount = 0.

•	 The	frequency	range	that	is	filtered	starts	at	35	Hz,	ends	at	about	3	kHz,	and	is	
equally distributed over the amount range.

•	 The	filter	 resonance	starts	at	 0,2	and	goes	up	 to	about	0,5	over	 the	amount	
range.

•	 The	number	of	stages	of	the	filter	 inside	the	Hi-Pass	effect	varies:	Up	to	the	
middle position of the amount knob three stages are used, with an amount 
value	between	50%	and	60%	four	stages	are	used,	and	above	60%	five	stages.

•	 additionally, a spreading parameter that increases all over the amount range, 
acts on the cut-off frequency differences between the stages.

Echo
the echo and the Delay effect (see next section) are delay effects where copies 
of the original signal are inserted into the output. this results in an echoic im-
pression. the fX amount knob controls the dry/wet ratio and effect dependent 
parameters.

let’s have a look at the parameters for the echo effect:

•	 the dry/wet range for echo is 0% (only dry) to 100% (only wet).

•	 the delay time depends on the Bpm of the player and is 1/2 beat in the amount 
range	from	0–80%.	Above	80%	the	delay	time	is	shortened:	first	1/4	beat,	then	
1/8,	1/16	and	finally	1/32	beat	when	the	Amount	knob	is	at	its	maximum	posi-
tion.	The	delay	time	is	not	changed	abruptly	but	slowly	in	the	upper	fifth	position	
of the knob. playing around in this knob range leads to very interesting acceler-
ating delay effects, that sound similar to a tape delay.

•	 the feedback starts at about 25% and increases up to 63% all over the amount 
range. the feedback parameter controls how much of the effect signal is fed 
back into the effect. By feeding the effect signal back into the effect engine, the 
intensity of the effect is increased.
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Dry Signal

Wet Signal
Dry/Wet

Feedback Loop

Delay Effect

the echo effect has a nice trail: keep the amount knob open and pause the player 
to hear it.

Delay
the Delay effect is the second delay effect in the croSS fX suite; one of the main 
differences	between	Echo	and	Delay	 is	that	Delay	uses	a	fixed	delay	time	of	1/2	
beat; the delay time is in sync to the tempo of the current track. let’s have a look 
at the parameters you can control with the fX amount knob:

•	 the dry/wet range for Delay is 0% (only dry) to 100% (only wet).

•	 Delay	uses	a	fixed	delay	 time	of	1/2	beat,	which	 is	controlled	by	 the	current	
playback Bpm of the track.

•	 the possible feedback values range from 0% to 65% and are equally distributed 
over the knobs positions.

•	 Delay	uses	a	low-pass	filter	on	the	effect	signal.	It	kicks	in	when	the	Amount	
is at 80%. the start cut-off frequency is 14 kHz and it goes down to 500 Hz, the 
more the amount knob is turned clockwise. at the same time the resonance 
(Q	factor)	of	the	filter	 increases.	The	resonance	causes	those	tones	near	the	
cut-off frequency to be emphasized and the other tones to be attenuated. the 
effect	of	the	filter	is	more	prominent	when	the	resonance	is	higher.	Further-
more,	with	higher	resonance	values,	filters	tend	to	produce	an	oscillation	by	
themselves; this effect is called self-oscillation and creates interesting sounds.

Phaser
the phaser effect uses a phase-shifted copy of the input and mixes it with the origi-
nal signal. When the original and the phase-shifted signal are combined it creates 
one or several notches in the frequency spectrum; those frequencies are elimi-
nated in the output signal. this creates the typical frequency sweep of the phaser. 
To	get	the	phase	shifted	copy	the	signal	is	sent	through	an	all-pass	filter;	this	filter	
type lets all frequencies pass through, but it changes the phase response.

you can control the following parameters with the fX amount knob:

•	 the possible feedback values range from 0% to 75% and are equally distributed 
over the knobs positions.

•	 the depth can be set between 75% and 100%; the possible values are equally 
distributed over the knobs positions.
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•	 the frequency sweep can be set between 434 Hz and 2020 Hz; the possible 
frequency values are also distributed over the knobs positions

X-Phaser
the X-phaser effect is a variation of the phaser effect. unlike the phaser effect, 
X-Phaser	uses	a	fixed	feedback	value	and	the	rate	of	the	LFO	used	for	the	effect	
is beat-synced to the current playing track. Here are all parameters that can be 
controlled with the fX amount knob:

•	 the feedback value is always 75%.

•	 the depth can be set in a range from 0% to 100%.

•	 the frequency sweep can be set between 80 Hz and 2020 Hz/6 kHz.

•	 the lfo rate is beat-synced: 16 beats until the amount knob is in the middle 
position;	8,	4,	1	beat(s)	when	the	Amount	knob	is	between	50	and	75;	and	finally	
1, 1/2, and 1/4 beat when the amount knob is between 75 and 100.

Flanger 
the flanger effect adds a time-delayed copy of the original signal and the very 
short delay time continuously changes. Because the delay time is very short this 
isn’t	perceived	as	an	echo.	Instead	the	delay	creates	kind	of	a	filter	effect	produc-
ing notches in the frequency spectrum. the result is that groups of frequencies are 
filtered.	And	because	the	delay	time	is	changing	those	notches	in	the	frequency	
spectrum change as well. this in turn creates the typical dynamic swirl effect of 
the flanger.

let’s have a look at the parameters for the flanger effect:

•	 the dry/wet is in fact replaced by an effect level whose value is 0% at min 
amount value and increases till 100% at the max amount value.

•	 flanger uses a small feedback range: the minimum feedback value is 50% and 
it increases up to 66%.

•	 the lfo of the flanger effect uses a saw-tooth waveform (always falling) and 
the oscillation cycle is dependent on the current playback Bpm. turning the 
Amount	knob	clockwise	selects	the	following	values:	1,	2,	4,	8,	and	finally	16	
beats.

Jet
the Jet effect is a variation of the flanger effect. Jet uses different presets of the 
parameters that can be controlled by the fX amount knob:

•	 as for the flanger effect dry/wet is replaced by an effect level which value is 0% 
at min amount value and increases till 100% at max amount value.
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•	 the feedback value starts at about 50% and increases to about 80%, if you turn 
the amount knob clockwise. With a higher feedback value the sound of the Jet 
becomes more metallic.

•	 the Jet effect uses a low frequency oscillator that creates a sinus waveform to 
modulate/modify the audio signal. the speed of the lfo is not Bpm dependent 
and its range goes from 0.1 Hz to 5 Hz. 

Transform
transform is a tremolo-style effect: it repetitively changes the amplitude (level) 
of the player’s audio signal. the change of the amplitude sounds as if the audio 
needs to pass a gate, those doors are rhythmically opened and closed. the depth 
parameter of the effect is always 100%. 

you can change the following effect parameters with the amount knob:

•	 The	LFO	uses	a	square	waveform	in	the	first	50%	of	the	Amount	knob;	in	the	
second 50% a sine waveform is used.

•	 the amplitude change is beat-synced to the tempo of the currently playing 
track. the rate is 2 beats when the knob is between 0 and 25; it is 1 beat be-
tween	25	and	50;	it	is	1/2	beat	between	50	and	80;	and	finally	1/4	beats	between	
80 and 100. the shorter the chosen rate, the more often the level changes.

Chopper
The	Chopper	effect	is	an	auto	filter	that	allows	you	to	control	the	LFO	rate	and	the	
frequency	ranges	of	the	filter	all	with	one	knob.	The	Chopper	effect	uses	a	sine	
waveform to control the lfo. the following parameters are controlled with the fX 
amount knob:

•	 the depth can be set in a range from 0 to 100%.

•	 the lfo rate can be set to a tempo between 0,76 Hz to 24 Hz.

•	 The	low	minimum	frequency	that	is	filtered	can	be	set	between	781	to	569	Hz.

•	 The	low	maximum	frequency	that	is	filtered	can	be	set	between	1480	to	2680	
Hz.

•	 The	high	minimum	frequency	that	is	filtered	can	be	set	between	231	to	569	Hz.

•	 The	high	maximum	frequency	is	fixed	at	11900	Hz.

Crush
crush is a distortion effect; changing the sample rate and the bit depth of the origi-
nal audio signal creates the distortion. the fX amount knob can control the fol-
lowing parameters: 
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•	 The	filter	resonance	starts	at	20%	and	can	be	increased	to	25%.

•	 the down-sampling rate starts at 16 kHz (knob in the outermost left position) 
and it goes down to 722 Hz, the more you turn the amount knob clockwise.

•	 The	bit	resolution	changes	from	32	bit	down	11	bit	on	the	first	half	position	of	
the amount knob. from the middle position up to the outermost right position 
of the amount knob the bit depth changes from 11 down 10 bit.

Bliss
the Bliss effect is a white noise generator that is perfectly suited to build drama 
into a mix. When the amount knob is at the 0 and 100 position, the white noise is 
off. In the range from 1 to 99 the amount knob controls the following parameters 
of the white noise signal:

•	 the frequency of the white noise signal starts at 100 Hz and increase to 9 kHz.

•	 The	filter	resonance	starts	at	35%	and	goes	up	to	100%.

•	 the mix level of the white noise (level in relation to the audio from the player) 
starts at 100% then decreases at 50% when the knob position is at 92% (here 
the frequency is 6.5 kHz). When the knob is turned completely clockwise the 
mix level is 0%. 

Bi-Filter
The	Bi-Filter	is	a	bipolar	filter	that	behaves	as	a	Low-Pass	filter	when	the	Amount	
knob is turned from 50 down to 0, and this behaves like a Hi-pass filter when the 
knob	is	turned	from	50	up	to	100.	The	filter	is	off	when	the	knob	is	at	the	vertical	
position (12 o’clock). turning the knob out of the neutral position controls the cut-
off	frequency	and	the	resonance	of	the	filter:

•	 The	cut-off	frequency	of	the	Low-Pass	filter	ranges	from	5.4	kHz	down	to	80	Hz.

•	 The	cut-off	frequency	of	the	Hi-Pass	filter	ranges	from	7.4	kHz	up	to	11	kHz.

•	 For	both	filters	the	resonance	range	starts	at	6%	and	ends	at	3%.

Brake
the Brake effect simulates the stopping of a turntable. the amount knob is used to 
set the brake time, i.e. the time that it takes until the virtual turntable comes to a 
complete stop. the duration can be set in a range from 6 seconds to half a second. 
Set	the	brake	time	first,	and	then	switch	the	effect	on.	While	the	brake	effect	is	ac-
tive, you can still shorten or lengthen the brake time by turning the amount knob.
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Roll
the roll effect is a beat repeater. When you engage the effect by pressing fX on 
(the amount knob can be at the outermost left position), croSS takes an audio 
sample (2 beats) from the player and stores it in an internal buffer. 

then, when you turn the amount knob clockwise, the audio from the player is mut-
ed and only the sampled audio can be heard. the sampled audio is always beat-
synced to the Bpm of the currently playing track.

•	 you can use the amount knob to change the beat-length of the audio, which is 
repetitively outputted by the effect. the length of the repeated loop is 2 beats 
while the knob position is between 0 and 20; it is 1 beat when the knob is be-
tween 20 and 40; it is 1/2 beat between 40 and 60; it is 1/4 beat when the knob 
is	between	60	and	80;	and	finally	it	is	1/8	beat	when	the	knob	is	between	80	and	
100.

9.6 Recording
croSS DJ has an integrated recorder that you can use to record your mixes if you 
use internal mixer mode. croSS DJ also allows you to record the audio from each 
player. If you have an external mixer and wish to record your mixes you can con-
nect the record out or Booth output to an external recorder. this sections explains 
the settings for the mix recorder and how to record your mixes.

Configuring the Mix Recorder
Before	recording	your	first	mix	it	is	a	good	idea	to	open	the	Preferences	dialog	and	
to	configure	the	recording	settings.	

1 go to the menu and click File/Preferences. click the Recording 
button to open the settings panel for the mix recorder.

2 option Automatically start recording is disabled by default. In 
this	configuration	recording	starts	as	soon	as	you	press	the	Rec button in 
the recorder panel. If you activate Automatically start recording, clicking 
the Rec button puts the recorder in a waiting state; recording will start as 
soon as you start playback in any of the two players. 

3 click the Browse button next to recording directory to set the folder where 
croSS shall save the recording.

 If you use Windows the default folder is “my music/cross DJ” below your 
documents folder. on oS X the default folder is “music/cross DJ” is below 
your home directory.

4 click into the Naming pattern text box, if you want to change the change the 
pattern that croSS DJ	shall	use	for	your	recordings.	The	default	filename	
is composed from the date/time the recording started.
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 Hover your mouse over the textbox Naming pattern to see the placeholders 
that you can use in the pattern.

5 open the list Audio Format and select one of the four formats that croSS 
provides. 

 If you select ogg (ogg Vorbis format) you will see a slider where you can set 
the quality: a higher number delivers better audio quality for the price of a 
larger	file	size.

Recording your Mix
once you	have	configured	your	recording	settings	follow	these	steps	to	record	your	
mix:

1 Select which audio streams shall be recorded by clicking the correspond-
ing buttons on the Recorder panel. 

 you can record any combination of audio from player a, audio from player 
B,	and	Audio	from	Master	Mix.	Each	stream	is	recorded	into	a	separate	file.	
If	you	record	more	than	one	stream,	each	filename	will	be	extended	by	the	
stream name (player a, player B, master mix).

Record 
Player B

Record 
Player A

Record 
Master Mix

Start/Stop
Recording

2 click the Rec button on the recorder panel to start recording.

3 If you activated Automatically start recording, start playback on any of the 
players to start recording. otherwise recording will start when you press 
the Rec button.

 During the recording you can see the duration of the recording and the 
chosen	file	format	in	the	middle	section	of	the	Recorder	panel.

4 click the Rec button again to stop recording.
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TIP Digitize your Vinyl you can use the recorder to digitize your vinyl. con-
nect your turntable to the corresponding inputs of your audio interface, then 
configure	the	external	audio	source	as	described	in	section	“U-MIX	CONTROL	
pro and external audio Sources”. play your vinyl on the connected turntable 
and let the mix recorder digitize it.

9.7 Using Autoplay
croSS DJ can automatic play the tracks you selected and moved into the auto-
play panel. you can move tracks to autoplay by selecting them in listview and 
drag and drop them onto the Autoplay button in the dock. you can also right-/ 
ctrl-click on one track or on several selected tracks and choose Add to Autoplay 
in the context menu. 

then click the Autoplay button in the dock to open the autoplay panel.

you can change the order of the tracks by dragging them as you would in any other 
listview. use the Fade Time	slider	to	configure	the	timing	of	the	automatic	fading.	
the A/B selector (next to the MIX button) must be set to a player that is currently 
not playing. finally click on MIX to start autoplay.

If you wish	to	start	again	with	the	first	track,	once	the	last	track	in	your	
autoplay has ended, click the Repeat button in the right area of the auto-
play list button bar.

to change the playback order randomly, click the Shuffle button. the new 
playback order of the tracks will be indicated by the numbers in the # 
column of the track list.
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Backup  
your Data

It	is	good	practice	to	back	up	the	data	files	CROSS	DJ	creates,	as	well	as	your	audio	
tracks of course. In case of a hard drive failure a backup will help you to get your 
croSS DJ setup back to a running state very quickly.

To	create	a	backup	of	 the	data	files	of	CROSS	DJ	make	sure	 to	 include	the	 two	
following folders:

• Collection Folder	 The	collection	folder	is	the	folder	where	the	collection	files	
reside	that	you	create	with	CROSS	DJ.	The	collection	files	use	the	extension	.db	
and can be found in the following location:

• OSX /users/[username]/music/cross DJ

• Windows XP c:\Document and Settings\[username]\music\cross DJ

• Windows 7 c:\users\[username]\music\cross DJ

•	 The	collection	file	contains	information	about	your	tracks,	their	location	and	the	
tags	of	your	media	files.

• Peak Folder In	 the	default	configuration	 the	Peak	 folder	resides	below	the	
collection folder. as long as you haven’t changed the peak files location on the 
Preferences/General	dialog,	it	is	sufficient	to	save	the	content	of	the	Collection	
folder and all its subfolders. 

In	 the	 case	 that	 you	have	 changed	 the	 location	 of	 the	Peak	files	 you	 should	
check its current location on the Preferences/General dialog and make sure, 
that this folder is included in your backup scenario as well.

The	 peak	 files	 contain	 information	 that	 CROSS	 DJ	 gathers	 during	 the	 track	
analysis and all playback information that you create. these are: the peaks/
transients of the track, the tempo (Bpm), the locators, cue point, the track gain 
and information about any loops you have set.

In	the	worst	case	of	a	hard	drive	failure	you	want	to	ensure	that	the	audio	files	of	
the tracks that you imported into the collection are restored to your original loca-
tion. 
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Default  
Keyboard  
Shortcuts

Collection and Track Management

Function Windows Mac OS X

Import file (Ctrl)+(I) (cmd)+(I)

new collection (Ctrl)+(N) (cmd)+(N)

open collection (Ctrl)+(O) (cmd)+(O)

Save collection (Ctrl)+(S) (cmd)+(S)

Save collection as (ª)+(Ctrl)+(S) (ª)+(cmd)+(S)

Switching Layouts

Function Windows Mac OS X

full Screen (F11) (ª)+(cmd)+(F)

toggle Display mode (F7) (ª)+(cmd)+(0) (zero)

Player: Activating, Loading and Playback

Function Windows Mac OS X

toggle active player (ÿ), (ª)+(ÿ) (ÿ), (ª)+(ÿ)

toggle active Browsable (Ctrl)+(æ), 
(Ctrl)+(Æ)

(cmd)+(æ), 
(cmd)+(Æ)

Scroll through collection (¼), (½) (¼), (½)

load into player a (ª)+(Ctrl)+(æ) (alt)+(cmd)+(æ)

load into player B (ª)+(Ctrl)+(Æ) (alt)+(cmd)+(Æ)

play/pause active player (________) (spacebar) (________) (spacebar)

play/pause all players (ª)+(________) (ª)+(________)

Smart Seek Backward (Alt)+(æ) (Alt)+(æ)
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Function Windows Mac OS X

Smart Seek forward (Alt)+(Æ) (Alt)+(Æ)

Vinyl mode (V) (V)

Player: Cue Points, Looping

Funktion Windows Mac OS X

Set In point (I) (I)

Set In point (O) (O)

loop on/off (L) (L)

auto loop, select length (J), (K) (J), (K)

auto loop, trigger (U) (U)

Player: Tempo, Pitching and Synchronisation

Funktion Windows Mac OS X

tap tempo (T) (T)

Tempo	up,	normal/fine (F), (ª)+(F) (F), (ª)+(F)

Tempo	down,	normal/fine (R), (ª)+(R) (R), (ª)+(R)

tempo, reset pitch fader (ª)+(0) (zero) (ª)+(0) (zero)

pitch mode (P) (P)

pitch Bend up (D) (D)

Pitch	Bend	up,	fine (ª)+(D) (ª)+(D)

pitch Bend up, coarse (Ctrl)+(D) (cmd)+(D)

pitch Bend down (E) (E)

Pitch	Bend	down,	fine (ª)+(E) (ª)+(E)

pitch Bend down, coarse (Ctrl)+(E) (cmd)+(E)

match active player to other (M) (M)

Sync active player to other (S) (S)
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Player: Cue Points and Locators

Function Windows/Mac OS X

cue (C)

cue/play (¢)

Set cue (ª)+(C)

Set/Delete locator 1 (1)/(ª)+(1)

Set/Delete locator 2 (2)/(ª)+(2) 

Set/Delete locator 3 (3)/(ª)+(3)

Set/Delete locator 4 (4)/(ª)+(4)

Set/Delete locator 5 (5)/(ª)+(5)

Set/Delete locator 6 (6)/(ª)+(6)

Mixer

Function Windows Mac OS X

cue/monitor player a (A) (B)

cue/monitor player B (B) (B)
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troubleshooting 
and faQ

B.1  Software related Questions

The audio tracks are not playing back
•	 make sure you have selected the correct audio interface in the audio prefer-

ences window.

•	 make sure you activated the correct audio inputs and outputs of your audio 
interface in the audio preferences window.

•	 make sure you selected the correct routing mode in the audio preferences win-
dow.

There is no sound going out of the speakers
•	 check for activity on the output meter of the internal mixer. If there is no re-

sponse from the meter, check all the controls of the mixer: faders, gain, kills, 
etc.

•	 If you are in external mixer mode, check the connections from your audio inter-
face to your mixer and from your mixer to your sound system. make sure you 
have the proper inputs selected on your mixer.

There are some audio dropouts or slow response
•	 change the buffer size setting in the audio preferences. If you hear crackling 

sounds, it means your latency setting is too low, choose a larger buffer size and 
test again.

•	 close all applications that are not needed.

•	 Disable	your	anti-virus,	spyware	and	firewall	software.

•	 turn off your computer’s wireless card (or disconnect from the Internet).

•	 close all background processes that are currently not needed. for example on 
Windows, press (Ctrl)+(Alt)+(Del), open the task manager, go to the pro-
cesses tab and close the processes.
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•	 If	you	are	very	serious	about	DJing,	the	first	thing	to	do	is	partition	your	hard	
drive and dedicate a clean install only to mixVibes. make sure not to use the 
internet if you have booted your system from the dedicated croSS DJ partition. 
this will avoid all potential worms and backdoors that can considerably slow 
down your application.

Where do I find my license key/serial number?
the license key is printed on the back of the installation cD sleeve.

How do I recover my lost license key/serial number? 
We recommend keeping your license key/serial number by registering on the fo-
rum, and entering it in the space provided. We’ll be able to recover it for you in case 
you lose it. please note that we cannot provide additional serial numbers.

How to I get software updates? 
to download the latest version of your mixVibes software, you will need to be reg-
istered on the mixVibes forum.

follow these steps to register:

1 go to the mixVibes at http://forum.mixvibes.com

2 click on Register in the Board Index sidebar. 

3 read the terms and click on “I agree to the terms”.

4	 Fill	 out	 your	 profile	with	 your	 user	 name,	 a	 valid	 e-mail	 address,	 and	 a	
password. 

IMPORTANT you will need your software license key to complete the 
registration.	You	will	find	the	key	on	the	back	of	your	installation	CD	
sleeve.

5 you will receive an e-mail with an activation link to complete the registra-
tion. 

follow these steps to download and install the update:

1 login to the forum and go to the Download center.

2	 Select	your	version	of	MixVibes	and	find	the	latest	update.

3 click the Download button near the bottom of the page.

4 Once	the	download	is	finished,	extract	the	folder	and	run	the	EXE	(PC)	or	
DMG	(MAC)	file.

http://forum.mixvibes.com
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Why do I hear an electrical sound while nothing is playing? 
If you hear a rumbling sound in the background, this is a grounding problem. this 
happens with laptops that have a power supply with a ground connection (3-pin 
plugs). to correct this problem, use a ground loop isolator on the master output 
of your mixer.

I have a particular MP3 that won’t play /plays badly/takes a 
long time to load/crashes the program. What should I do? 
In	most	cases	the	cause	of	this	symptom	is	a	corrupted	file	and	it	could	be	neces-
sary	to	delete	this	file	from	your	collection.	There	are	some	free	tools	available	
that	can	check	if	a	MP3	file	is	defect	or	not.	Use	your	favourite	search	engine	and	
search	for	“mp3	checker”	and	test	the	MP3	file	that	doesn’t	play	or	that	causes	
croSS DJ to crash.

If	you	find	the	file	that	caused	the	problem,	please	go	to	the	MixVibes	forum	and	
inform	our	support	team	about	the	issue.	By	reporting	damaged	or	corrupt	files,	
you can help the developers to improve croSS’ ability to handle damaged mp3 
files	in	future	versions.

B.2  Controller related Questions

The U-MIX CONTROL controller has no effect on CROSS DJ/ 
CROSS DJ LE
If the power leD is off:

•	 check that the poWer switch on the rear of the controller is not set to off or 
to the ac position.

•	 check/change the uSB cable and turn the poWer switch on the rear to the 
uSB position. 

•	 use an adaptor and set the poWer switch on the rear to the ac position. 

If the power leD is on:

•	 try to connect the controller to another uSB port. 

•	 close the software. reconnect the uSB cable of the controller and make sure 
that it is powered correctly. restart croSS DJ/croSS DJ le.

How can I determine the firmware version of  
U-MIX CONTROL PRO and U-MIX CONTROL 2?
1 make sure your controller is connected via uSB to the computer.

2 power the device off.
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3 press and hold the buttons SHIFT and BASS_B on the controller.

4 Switch the controller on while pressing the buttons SHIFT and BASS_B. 

5	 The	firmware	version	(X.Y.)	is	encoded	into	the	LEDs.	The	LEDs	for	player	A	
show the major version number (X), the leDs for player B the minor version 
number (y). 

•	 X (on player a): 1 (pItcH moDe), 2 (Select), 3 (locator1), 4 (loca-
tor2), 5 (locator3), 6 (VInyl), 7 (BenD-), 8 (BenD+), 9 (Sync)

•	 y (on player B): 1 (pItcH moDe), 2 (Select), 3 (locator1), 4 (loca-
tor2), 5 (locator3), 6 (VInyl), 7 (BenD-), 8 (BenD+), 9 (Sync)

6 press SHIFT to return to normal mode.

How can I upgrade the firmware of my controller?
1 make sure your controller is connected via uSB to the computer.

2 power the device off.

3 press and hold the buttons SHIFT and BROWSE on the controller.

4 Switch the controller on while pressing the buttons SHIFT and BROWSE. 

5 release the buttons SHIFT and BROWSE. the buttons Source A and Source 
B should light up now.

6 a new drive named “midiupgDisk” should be found on your system.

7	 Drag	and	drop	the	firmware	file	onto	the	“midiUpgDisk”	drive.	Make	sure	
that	you	use	the	correct	firmware	file	for	your	controller.

•	 The	firmware	files	for	U-MIX	CONTROL	PRO	use	the	following	naming	
pattern: u-mIX_pro_*V*.bin

•	 The	 firmware	 files	 for	 U-MIX	 CONTROL	 2	 use	 the	 following	 naming	 
pattern: u-mIX_2_*V*.bin

8	 Once	the	firmware	file	is	dropped	the	upgrade	process	begins.	LEDs	on	the	
controller inform you about the update progress:

•	 Update	Data	30%	=	KILL	BASS	A/B	are	flashing

•	 Update	Data	60%	=	KILL	MID	A/B	are	flashing

•	 Update	Data	90%	=	KILL	TREB	A/B	are	flashing

•	 Update	Success	=	LOAD	A/B	are	flashing

•	 update error = loaD a/B are off

9	 After	the	firmware	is	updated,	the	LEDs	will	turn	off.



121

Troubleshooting and FAQ

Can I use U-MIX CONTROL PRO or U-MIX CONTROL 2 with other 
DJ software than CROSS DJ/CROSS DJ LE?
yes, both u-mIX control controllers are standard mIDI controllers that send 
mIDI commands. u-mIX control pro and u-mIX control 2 can be used with 
any software that accepts mIDI commands.
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C/ 
list of mIDI  
messages

the controls in the two player sections, in the mixer section and in the general 
section of u-mIX control pro/ u-mIX control 2 send their messages on the 
following mIDI channels:

•	 player a: mIDI channel 1

•	 player B: mIDI channel 2

•	 mixer: mIDI channel 3

•	 Shift + player a: mIDI channel 4

•	 Shift + player B: mIDI channel 5

•	 Shift + mixer: mIDI channel 6

Player Section (Controller to Computer)

Control Name Message Type Key/Note/Value MIDI Channel

cue note on/off 0x1 a=1, B=2

play note on/off 0x2 a=1, B=2

Sync note on/off 0x3 a=1, B=2

pitchbend – note on/off 0x4 a=1, B=2

pitchbend + note on/off 0x5 a=1, B=2

pitchbend Slider pitchbend 0xe a=1, B=2

Vinyl note on/off 0x7 a=1, B=2

pitch mode note on/off 0x8 a=1, B=2

Select note on/off 0x9 a=1, B=2

locator 1 (Select = off) note on/off 0xa a=1, B=2

locator 2 (Select = off) note on/off 0xB a=1, B=2

locator 3 (Select = off) note on/off 0xc a=1, B=2

locator 4 (Select = on) note on/off 0x18 a=1, B=2

locator 5 (Select = on) note on/off 0x19 a=1, B=2
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Control Name Message Type Key/Note/Value MIDI Channel

locator 6 (Select = on) note on/off 0x1a a=1, B=2

loop (push) note on/off 0xD a=1, B=2

loop (turn) 1 control change 0xD a=1, B=2

fX Select (push) note on/off 0xe a=1, B=2

fX Select (turn) 1 control change 0xe a=1, B=2

fX amount control change 0xf a=1, B=2

1 relative encoder, see section on page 125.

Jogwheels (Controller to Computer)
the jogwheels on u-mIX control pro are touch sensitive and the jogwheels on 
u-mIX control 2 are not. for this reason the messages sent by the jogwheels are 
slightly	different.	The	first	table	shows	the	MIDI	messages	for	U-MIX	CONTROL	2:

Condition Message  
Type

CC Number Value MIDI Channel

Wheel is touched 
and turned

control 
change

0x16 Forward:  
0x41 – 0x7f 
Rewind: 
0x3f–0x00

a=1, B=2

Wheel is no longer 
turned 

control 
change

0x16 0x40 a=1, B=2

the second table shows the mIDI messages sent by u-mIX control pro:

Condition Message  
Type

Key/Note, 
CC Number

Value MIDI Channel

Wheel detects an 
initial contact

note on/ 
note off

0x16 0x00 = release,  
0x7f = push

a=1, B=2

top wheel is  
touched and wheel 
is turned 

control 
change

0x16 Forward:  
0x41 – 0x7f 
Rewind: 
0x3f–0x00

a=1, B=2

top wheel is no 
longer turned

control 
change

0x16 0x40 a=1, B=2
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Condition Message  
Type

Key/Note, 
CC Number

Value MIDI Channel

outer wheel is 
touched and  
turned

control 
change

0x17 Forward:  
0x41 – 0x7f 
Rewind: 
0x3f–0x00

a=1, B=2

outer wheel is no 
longer turned 

control 
change

0x17 0x40 a=1, B=2

Mixer Section (Controller to Computer) 

Control Name Message Type Key/Note MIDI Channel

Headphones monitor note on/off 0x10 a=1, B=2

gain control change 0x11 a=1, B=2

eQ treb (turn) control change 0x12 a=1, B=2

eQ treb Kill (push) note on/off 0x12 a=1, B=2

eQ mid (turn) control change 0x13 a=1, B=2

eQ mid Kill (push) note on/off 0x13 a=1, B=2

eQ Bass (turn) control change 0x14 a=1, B=2

eQ Bass Kill (push) note on/off 0x14 a=1, B=2

Volume fader control change 0x15 a=1, B=2

cross fader control change 0x1 3

master Volume control change 0x3 3

monitor mix (front panel)control change 0x7 3

Browser Section (Controller to Computer) 

Control Name Message Type Key/Note MIDI Channel

Browse (push) note on/off 0x4 3

Browse (turn) 1 control change 0x4 3

load a control change 0x5 3

load B note on/off 0x6 3

Shift Button note on/off 0x2 3

1 relative encoder, see section on page 125.
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Relative Encoders
Several	of	the	knobs	act	as	relative	encoders,	i.e.	their	value	field	will	indicate	a	
relative change. 0 means that no change occurred, values 01 to 63 describe a posi-
tive change and values 127 down to 64 describe a negative change.

Value Description

0x00 no change occurred. control is stationary.

0x01 the controller incremented its value by 1 since the last report

0x02 the controller incremented its value by 2 since the last report

… …

0x3f the controller incremented its value by 63 since the last report

0x40 the controller decremented its value by 64 since the last report

0x41 the controller decremented its value by 63 since the last report

0x7e the controller decremented its value by 2 since the last report

0x7f the controller decremented its value by 1 since the last report

LED (Computer to Controller) 
the following table shows the mIDI messages for the different leDs on the con-
troller.

Control Name Message Type Key/Note MIDI Channel

master clip note on/off 0x3 3

treb note on/off 0x12 a=1, B=2

mid note on/off 0x13 a=1, B=2

Bass note on/off 0x14 a=1, B=2

fX note on/off 0xe a=1, B=2

loop note on/off 0xD a=1, B=2

you can send a value to these leDs and to all buttons with an integrated leD to 
control the leD state. the following table shows the values you can use:

Value LED Status

0x7f (=127 decimal) leD is on

0x00 (=0 decimal) leD is off

0x14 (=20 decimal) leD blinks every 0,2s

0x28 (=40 decimal) leD blinks every 0,4s



Value LED Status

0x3c (=60 decimal) leD blinks every 0,6s

0x50 (=80 decimal) leD blinks every 0,8s

0x64 (=100 decimal) leD blinks every second 
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D/ 
u-mIX control 
pro – technical 
Specifications

General Information
•	 Dimensions: 375mm (W) X 202.6mm (D) X 64 mm (H)

•	 Weight: 1.86kg

•	 power Source Dc: 6V, 1.5a

•	 ambient temperature 23 +/- 2 degc

•	 relative Humidity 65% +/- 5%

•	 note: measurements can be carried out between 5 degc to 35 degc and 45% 
to 85% relative humidity.

Features
•	 uSB mIDI controller + Digital mixer

•	 2 touch sensitive Jogwheels

•	 2 external phono/line Input

USB Slave Player Section  
(Signal Format: MP3, 128KBPS, SONY SOUND FORGE8.0)
• Output Level  

output 1/2/3/4: 2V +/-1dB (1 KHz, 0dB, tcD782 trK2)  
phones out: 1.3V +/-1dB (1 KHz, 0dB, tcD782 trK2)

• Frequency Response:  
output 1/2/3/4: 17-16 KHz +/-2dB (tcD781 trK1, 4, 16)

• THD+N: 
output 1/2/3/4: less than 0.02% (tcD782 trK2, W/20KHz lpf, a-WeIgHteD)

• SN Ratio:  
output 1/2/3/4: more than 70dB (tcD782 trK2, 8, W/20KHz lpf, a-WeIgHteD)

• LR Separation:  
output 1/2/3/4: more than 70dB at 1KHz (tcD782 trK2, 9, 11, W/20KHz lpf, 
a-WeIgHteD)
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Recording And Playback
• Line 1 KHz, 6dBV Input  

output1/2/3/4: 5dBV (2V) +/-2dB   
tHD+n: less than 0.05% (W/20KHz lpf, a-WeIgHteD)

• Phono 1 KHz, -41dBV Input  
output1/2/3/4: 0dBV (1V) +/-2dB  
tHD+n: less than 0.05% (W/20KHz lpf, a-WeIgHteD)

Maximum Input  
(1 KHz, Master Output, THD=1%, EQ Flat, Maximum Gain) 
•	 line: more than +4dBV

•	 phono: more than -36dBV

Maximum Output  
(EQ Flat, Maximum Gain, THD=1%, Load=100K Ohm) 
•	 output 1/2/3/4: more than +6dBV (2V) 

•	 phones: more than +1.6dBV (1.2V) loaD=32 oHm

Mic Player Section
•	 mic level: 10K ohm/-54dBV (out1/2/3/4:0dB (1V)+/-1dB)

•	 mic tHD+n: less than 0.15%@1KHz (w/20kHz lpf, a-WeIgHteD)

•	 mic S/n: more than 64dB

Note
The	specifications	are	subject	 to	 change	 to	any	 improvement	by	negotiations	 in	
advance.
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E/ 
Safety  
Instructions

these safety instructions apply if you are using the controller u-mIX control 
pro or u-mIX control 2. 

•	 read these Instructions.

•	 Keep these Instructions.

•	 Heed all Warnings.

•	 follow all Instructions.

•	 Do not use this apparatus near water.

•	 clean only with a damp cloth.

•	 Do not block any of the ventilation openings. Install in accordance with the 
manufacturer’s instructions.

•	 Do not install near any heat sources such as radiators, heat registers, stoves, 
or	other	apparatus	(including	amplifiers)	that	produce	heat.

•	 Do not defeat the safety purpose of the polarized plug. the wide blade is pro-
vided	for	your	safety.	If	the	provided	plug	does	not	fit	into	your	outlet,	consult	an	
electrician for replacement of the obsolete outlet.

•	 protect the power cord from being walked on or pinched particularly at the 
plug, convenience receptacles, and point where they exit from the apparatus.

•	 Only	use	attachments/accessories	specified	by	the	manufacturer.

•	 Use	only	with	a	cart,	stand,	tripod,	bracket,	or	table	specified	by	the	manufac-
turer, or sold with the apparatus. When a cart is used, use caution when moving 
the cart/apparatus combination to avoid injury from tip-over.

•	 unplug this apparatus during lighting storms or when unused for long periods 
of time.

•	 Refer	all	servicing	to	qualified	service	personnel.	Serving	is	required	when	the	
apparatus has been damaged in any way, such as the power-supply cord or 
plug is damaged. also if liquid has been spilled or objects have fallen into the 
apparatus, the apparatus has been exposed to rain or moisture, does not oper-
ate normally, or has been dropped.
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Safety Instructions

WARNING

To	reduce	the	risk	of	the	fire	or	electric	shock,	do	not	expose	this	apparatus	to	
rain or moisture. the apparatus shall not be exposed to dripping or splashing 
and	 that	no	objects	filled	with	 liquids,	such	as	vases,	shall	be	placed	on	 the	
apparatus.

    

CAUTION

  

CAUTION   to reduce the risk of electric shock, 
do not remove any cover. no user-serviceable 
parts	inside.	Refer	servicing	to	qualified	service	
personnel only.

The	 lightning	 flash	 with	 arrowhead	 symbol	 within	 the	 equilateral	
triangle is intended to alert the use to the presence of uninsulated 
“dangerous voltage” within the product’s enclosure that may be of 
sufficient	magnitude	to	constitute	a	risk	of	electric	shock.

the exclamation point within the equilateral triangle is intended to 
alert the user to the presence of important operation and mainte-
nance (servicing) instructions in the literature accompanying this 
appliance.

CAUTION

to prevent electric shock, do not use this polarized plug with an extension cord, 
receptacle or other outlet unless the blades can be fully inserted to prevent the 
exposure of a blade.

Index

nDeX
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Index

A
amount knob, effects  104
aSIo protocol  30
audio cache  71
Audio	Interface,	selecting	and	config-

uring  25
audio latency, explained  29
automatically start recording, setting  

110
autoplay  111

repeat  112
shuffle		112

B
Beatgrid

analysis  66
clear beatgrid  69
define	downbeat		69
define	user	beatgrid		70
move downbeat  69
shrink/expand  68
tools  67

Beat repeater  110
Bi-filter, effect  109
Bliss, effect  109
Bpm, halve or double  69
Brake, effect  109

C
chopper, effect  108
clear Beatgrid  69
clicks and pops

audio latency  30
audio latency time  28

core audio  30
crush, effect  108
cue point

jumping to  102

D
Define	Downbeat		69
Delay, effect  106
Dual Stereo, routing mode  29

E
echo, effect  105
effect

amount knob  104
enabling  104
selecting  104

effects
Bi-filter  109
Bliss  109
Brake  109
chopper  108
crush  108
Delay  106
echo  105
flanger  107
Hi-pass  105
Jet  107
low-pass  104
phaser  106
roll  110
transform  108
X-phaser  107

end of track alarm, setting  78
external mixer mode
configuring	U-MIX	 

control pro  19
external mixer, routing mode  29

F
flanger, effect  107

G
gain analysis  66
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Index

H
Head-up Display

beat matcher  74
Sync-meters  58

Hi-pass, effect  105
History node  80
Hot cues.  siehe locator;  see locator
Hybrid, pitch mode  95

I
Importing

collections from other  
DJ Software  64

folders  63
tracks from itunes  63

J
Jet, effect  107

L
latency time, explained  29
lead In/lead out, setting  78
limiter  29
locator

deleting  103
jumping to  103
setting  102

low-pass, effect  104

M
master limiter  29
mix recording  111

N
naming pattern, recording  110

O
optimizing collection  94

P
peak analysis  66
phaser, effect  106
pitch Bending  96

range  97
preferences, dialog

audio latency   28

R
recording
configuration			110
mix  111
naming pattern  110

roll, effect  110
routing mode

Dual Stereo  29
external mixer  29
Simple Stereo  29
Split mono  29

S
Show Beatgrids, option  75
Show Sync-meters  75
Simple Stereo, routing mode  29
Snap  98
Snap length  98
Speed, pitch mode  95
Split mono, routing mode  29
Steinberg, aSIo protocol  30
Synchronisation mode  76
Sync-meters  75

T
tempo, pitch mode  95
tracks, quality  82
transform, effect  108
turntable brake  109

U
u-mIX control pro
configuring	for	external	mixer	mode		

19
u-mIX control pro/2

effects  104
locators  103
mIDI messages  122

user Beatgrid+  70

W
White noise generator  109

X
X-phaser, effect  107
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•	 Contact  
for all technical or sales information, please contact your local reseller 
or mixVibes directly:

mixVibes 
4, rue de la Sablière 
92230 gennevilliers 
france 
www.mixvibes.com

•	 Technical Support 
please visit our online forum at http://forum.mixvibes.com

•	 Sales Questions  
please send an email to sales@mixvibes.com

copyright © 2011 mixVibes. all rights reserved.

the contents of this guide may change without prior notice. Best efforts 
have been put forth to insure the accuracy of the contents of this guide. mix-
Vibes is not liable for any errors, typographical or other, contained herein. 
Except	as	specifically	permitted	herein,	no	portion	of	 the	 information	on	
this guide may be reproduced in any form or by any means without the prior 
written permission of mixVibes. trademarks and trade names displayed on 
this guide are the property of their respective owners.

this guide may be updated from time to time. please check our website at 
http://www.mixvibes.com for updates. 

mixVibes
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